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Notice

1.

13.
14,

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user's manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE
IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

. Itis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or

transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)’ means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.

Trademarks
Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.

© 2021 Renesas Electronics Corporation. All rights reserved.



General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.

1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LS| are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal
become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between ViL (Max.)
and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi4 (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LSl is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit+ (RSK+), the user accepts the following terms:

The RSK+ is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK+ is
assumed by the User. The RSK+ is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK+. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK+,
even if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK+ product:

This Renesas Starter Kit+ is only intended for use in a laboratory environment under ambient temperature and
humidity conditions. A safe separation distance should be used between this and any sensitive equipment. Its use
outside the laboratory, classroom, study area or similar such area invalidates conformity with the protection
requirements of the Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

e reorient the receiving antenna

¢ increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The useris advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit+ does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use Smart Configurator for RX
together with the e? studio IDE to create a working project for the RSK+ platform. It is intended for users
designing sample code on the RSK+ platform, using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to generate code and import it into e? studio, but does not
intend to be a complete guide to software development on the RSK+ platform. Further details regarding
operating the RX671 microcontroller may be found in ‘RX671 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK+ Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur within the body
of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to the text of
the manual for details.

The following documents apply to the RX671 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK+ Renesas Starter Kit+ for R20UT4879EG
hardware. RX671 User’s Manual
Tutorial Manual Provides a guide to setting up RSK+ environment, Renesas Starter Kit+ for R20UT4883EG
running sample code and debugging programs. RX671 Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK+ and | Renesas Starter Kit+ for R20UT4884EG

run the first sample. RX671 Quick Start Guide
Smart Configurator Provides a guide to code generation and importing Renesas Starter Kit+ for R20UT4885EG
Tutorial into the e? studio IDE. RX671 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK+. Renesas Starter Kit+ for R20UT4878EG
RX671 Schematics
Hardware Manual Provides technical details of the RX671 RX671 Group User’s RO1UHO0899EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation

Full Form

ADC

Analog-to-Digital Converter

API Application Programming Interface

bps bits per second

CMT Compare Match Timer

COM COMmunications port referring to PC serial port

CPU Central Processing Unit

E1/E2 Lite Renesas On-chip Debugging Emulator

GUI Graphical User Interface

IDE Integrated Development Environment

IRQ Interrupt Request

LCD Liquid Crystal Display

LED Light Emitting Diode

LSB Least Significant Bit

LVD Low Voltage Detect

MCU Micro-controller Unit

MSB Most Significant Bit

PC Personal Computer

PLL Phase-locked Loop

Prmod™ This is a Digilent Pmod™ Compatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification

PSU Power Supply Unit

RAM Random Access Memory

ROM Read Only Memory

RSK+ Renesas Starter Kit+

RTC Real Time Clock

SCI Serial Communications Interface

SPI Serial Peripheral Interface

TFT Thin Film Transistor

UART Universal Asynchronous Receiver/Transmitter

USB Universal Serial Bus

WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.



https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK+ is an evaluation tool for Renesas microcontrollers. This manual describes how to use the e? studio
IDE Smart Configurator plug-in to create a working project for the RSK+ platform.

1.2 Features

This RSK+ provides an evaluation of the following features:
« Project Creation with e2 studio.

« Code generation using the Smart Configurator plug-in.
o User circuitry such as switches, LEDs and a potentiometer.

The RSK+ board contains all the circuitry required for microcontroller operation.

R20UT4885EG0100 Rev. 1.00 Page 8 of 66
Moy 10.21 RENESAS



Renesas Starter Kit+ for RX671 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, how to use the Smart Configurator plug-in for the RX
family together with the e? studio IDE to create a working project for the RSK+ platform. The tutorials help
explain the following:

Project generation using e? studio

Detailed use of the Smart Configurator plug-in for e2 studio
Integration with custom code

Building the project in €2 studio

The project generator will create a tutorial project with two selectable build configurations:
e ‘HardwareDebug’ is a project built with the debugger support included. Optimisation is set to zero.

e ‘Release’ is a project with optimised compile options (level two) and ‘Outputs debugging information’
option not selected, producing code suitable for release in a product.

The tutorial examples in this manual assume that installation procedures described in the RSK+ Quick Start
Guide have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

These tutorials are designed to show you how to use the RSK+ and are not intended as a comprehensive introduction to
the e? studio debugger, compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more
in-depth information.

R20UT4885EG0100 Rev. 1.00 Page 9 of 66
Moy 10.21 RENESAS




Renesas Starter Kit+ for RX671 3. Project Creation with e? studio

3. Project Creation with e? studio

3.1 Introduction

In this section, the user will be guided through the steps required to create a new C project for the RX671
MCU, ready to generate peripheral driver code using Smart Configurator. This project generation step is
necessary to create the MCU-specific source, project and debug files.

3.2 Creating the Project

e Start e? studio and select a suitable location e
for the project workspace. Select a directory a5 workspace

e” studio uses the workspace directory to store its preferences and development artifacts,

Workspace: ‘C:\Wurkspace V“ Browse... I

[] Use this as the default and do not ask again
» Recent Workspaces

==

e In the Welcome page, click ‘Create a new
C/C++ project’.

(The Welcome page can also be opened
from 'Help'-> 'Welcome'.)

et an overview of the features.

Import evisting ¢ studio projectsfrom the flsystem or archive " Gothrough tutorials

Try out the samples

Find out wht i new

Quickly geting familar withthe tool

Tl vy show Welcome at start .

e In the ‘Templates for New C/C++ Project’ * New C/C++ Project
H H ‘ ) _> ‘
dialog, selecting ‘Renesas RX , Renesas Templates for New C/C+-+ Project
CC-RX C/C++ Executable Project’.
e Click ‘Next’.
All GCC for Renesas RX C/C++ Executable Project
CMake =D A (FC++ Executable Project for Renesas RX using the GCC
Make for Renasas RX Toolchain,
Renesas Debu
W GCC for Renesas RX C/C++ Library Project
PN A [/C++ Library Project for Renesas RX using the GCC
for Renesas RX Toolchain.
Renesas CC-RX C/C++ Executable Project
fE\ A G/C++ Project for Renesas RX using the Renesas CCRX
toolchain.
Renesas CC-RX C/C++ Library Project
I A (/C++ Library Project for Renesas RX using the
Renesas CCRX toolchain.
® < Back Einish Cancel
R20UT4885EG0100 Rev. 1.00 RENESAS Page 10 of 66

May.10.21



Renesas Starter Kit+ for RX671 3. Project Creation with e? studio

e Enter the project name ‘SC_Tutorial’. Click | [E

‘Next'. New Renesas CC-RX Executable Project —
New Renesas CC-RX Executable Project

Project name: | SC_Tuterial

Use default location
C:\Workspace\SC_Tutorial Browse...
Create Directory for Project
default
Working sets

[] Add project to working sets New.,

® < Back Einish Cancel

e In the ‘Select toolchain, device & debug | [ENEEEES

settings’ dialog, select the options as Shown | |NewRenesas cc-RX Executable Project >
in the SCFeenShOt OppOSite. Select toolchain, device debug settings |l
e In Toolchains’ choose ‘Renesas CCRX'. occhein seings
nguage: @C Oc++

e The R5F5671EHXFB MCU is found under Pocram 2
RX600 > RX671 > Toolchain Version: |v3.03.00 “

Manage Toclchains...

RX671 - 144 pin. RT0S: None S

' . ' RTOS Version:
e Select 'E2 Lite (RX)' from the pulldown and
check 'Create Release Configuration' check e — T
box. Target Board: | Custom | Create Hardware Debug Configuration
) . , Download additional boards... [E2Lite (R) ~]
e Click ‘Next'. Target Device: | RSFSGTIEHFE
[] Create Debug Configuration
Unlock Devices...
RX Simulator ~
Endian: Little ~

Project Type: | Defadlt [ Create Release Configuration

e In the ‘Select Coding Assistant settings’ | [ENEE—C

dialog, select ‘Smart Configurator’. New Renesas CC-RX Executable Project =

Select Coding Assistant settings
H 3 t) L -

e Click ‘Next'.

[EUse Smart Configurator

Use Peripheral Cade Generator

Use FIT Confi
Download FIT Modules

Smart Configurator is a single User Interface that combines the functionalities of Code Generator and FIT
[Configurater which imports, cenfigures and generates different types of drivers and middleware medules.
Smart Configurator encompasses unified clock configuration view, interrupt configuration view and pin
lconfiguration view.

Hardware resources conflict in peripheral modules, interrupts and pins occurred in different types of drivers and
middleware modules will be notified.

(Smart Configurator is available only for the supported devices)

.. w

User Application 3
Driver and Middleware :"_;
Driver Code FIT Modules o
Configured in GUI Selected in GUI =L
and Generated and Imported m
c

o

5]

-

MCU Hardware

LB R R R R RRRRRRRERRRRRD D)

R20UT4885EG0100 Rev. 1.00 RRENESAS Page 11 of 66
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Renesas Starter Kit+ for RX671

3. Project Creation with e? studio

*  Click ‘Next. e
New Renesas CC-RX Executable Project |_;;(\
Settings The Contents of Files to be Generated |
‘What kind of initialization routine would you like to create?
Use Renesas Debug Virtual Console
Size of 1/0 Stream Buffer:
@ <gack | HNews | Emsh || Cancel
*  Asummary dialog will appear, click Finish' to | [N
complete the project generation. New Renesas CC-RX Executable Project —
Summary of project "SC_Tutorial” |
TOOLCHAIN NAME : Renesas CCRX
TOOLCHAIN VERSION : v3.03.00
GENERATION FILES:
® Next > Cancel
o Wait for file generation to start.
@O&  Operation in progress...
e In future, to skip the pop-up message on the B sl
I'Igh’[, CheCk the 'Remember my deCISIOI’]' @% Open the Smart Configurator perspective?
check box and click on 'Open Perspective'. =
emember my decwsi:m‘é
e The perspective changes automatically when

the Smart Configurator starts up.

) ¢/C++ %5 Debug <#Smart Configurator
BV B w W ©F SC_Tutorialscfg X

R20UT4885EG0100 Rev. 1.00

May.10.21
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

4. Smart Configurator Using the e? studio

4.1 Introduction

The Smart Configurator plug-in for the RX671 has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plug-in tool for generating template ‘C’ source code and
project settings for the RX671. When using Smart Configurator, it provides the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Generate Code’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are named ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where xxx’ is an acronym for the relevant MCU feature, for example
‘S12AD’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

By following the steps detailed in this Tutorial, the user will generate an e? studio project called SC_Tutorial.
The fully completed Tutorial project is contained in the RSK+ Web Installer
(https://www.renesas.com/rskrx671/install/e2) and may be imported into e2 studio by following the steps in the
Quick Start Guide. This Tutorial is intended as a learning exercise for users who wish to use the Smart
Configurator to generate their own custom projects for e2 studio.

The SC_Tutorial project uses interrupts for switch inputs, the ADC module, the Compare Match Timer (CMT),
the Serial Communications Interface (SCI) and uses these modules to perform A/D conversion. Results are
displayed via the virtual COM port in a terminal program and also on the PMOD display connected to the
RSK+.

Following a tour of the key user interface features of Smart Configurator in the tabbed pages (board, clocks,
components and pins), as well as a demonstration of building a project, the reader is guided through each of
the peripheral function configuration pages and familiarised with the structure of the template code, including
the process of adding their own code to the user code areas provided by the Smart Configurator
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

4.2 Project Configuration using Smart Configurator

In this section, a brief tour of Smart Configurator is presented. For further details of the Smart Configurator
paradigm and reference, refer to the RX Smart Configurator User's Guide: e? studio.
You can download the latest document from: https://www.renesas.com/smart-configurator.

The Smart Configurator initial view is displayed as illustrated in Figure 4-1.

< Workspace - SC_Tuterial/SC_Tutorial.scfg - € studio
File Edit Navigate Search Project RenmesasViews Run Window Help

b~ Bletact G v 8 45 Debug || 9 sC Tutorial HardwareDebug  ~ =i | B~ R il B g Q i~
X Q- 7 | @ oc++ %5 Debug | g#Smart Configurator
Epoeiboom] = O = o [EvcumpuRaege | = n
& 2 .. . = &

BE% Y $ Overview information ic = Bl a2 llA|R »

~ 25 SC_Tutorial Generate Code  Generate Report

Includes . 5 A

% e « General Informatiori @

% SC_Tutorial.scfg
[Z] SC_Tutorial HardwareDebug.l

This editor allows you to madify the settings stored in configuration file (.scfg)

Board

Allow board and device selection

Application under

Clocks =
development = -
Allow clock configuration L — = RENESAS
[M\dd\eware l |
Components Device
driver ‘ RTOS |

Allow software component selection and configuration
e e e Y
Pins.

Pins

Allow general pin configuration and pin configuration for selected software component

Interrupt
Allow general interrupt configuration and interrupt configuration for selected software compenent

< Overview | Board | Clocks| System| Components| Pins| Interrupts » Legend

B Consale bR B9y = 0 |8 3dl-vayFoyy (@ Ax-k-T557- ¥ § =0
[Smart Configurator Output 0 items.
i

MB6@RARA2: File generated:sr

v

en\general\r smc interrupt.c * || Description Type

Me6eRReR2: File generated mc_gen\general\r smc interrupt.h
Me6eesee2: File generated:srclsmc gen\r cenfighr bsp interrupt config.h ~
B

Figure 4-1 Overview page

Smart Configurator provides GUI features for configuration of MCU sub systems. Once the user has
configured all required MCU sub systems and peripherals, the user can click the ‘Generate Code’ button,
resulting in a fully configured e? studio project that builds and runs without error.
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

4.3 The ‘Board’ tabbed page

On the ‘Board’ tabbed page, set the board type and device type.
Click the 'Board' tab and it will be displayed as shown in Figure 4-2.

o
Device selection c
Generate Code Generate Report
Device selection B2y B3
Board: | Custom User Board P e

Device: | RSF5671EHxFB

Download more boards...

OverviewlBoardIClocks System | Components | Pins | Interrupts
Figure 4-2 Board configuration page

4.31 Board configuration page

Make sure that ‘Custom User Board’ is selected for the ‘board:’.

Device selection

Device selection

Board: |§Cuslum User Board VI

Device: | RSF5671EHxFB

Download more beards...

Figure 4-3 Select board
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

4.4 The ‘Clocks’ tabbed page

The ‘Clocks’ tabbed page configures clocks of the device selected. Clock source, frequency, PLL settings and
clock divider settings can be configured for the output clocks. Clock configurations will be reflected in the
r_bsp_config.h file in \src\smc_gen\r_config.

441 Clocks configuration

Figure 4-4 shows a screenshot of Smart Configurator with the Clocks configurations. Click on the ‘Clocks’ tab.
Configure the system clocks as shown in the figure. In this tutorial, we are using the on board 24 MHz crystal
resonator for our main clock oscillation source and the PLL circuit is in operation. The PLL output is used as
the main system clock and the divisors should be set as shown in Figure 4-4.

; s =
Clocks configuration
Generate Code  Generate Report
SCKCR (FCK[3:0) FlashiF clack (FCLK)
vee |33 (V) (Actual value: 33) ST AL &0 Lt
Frequency Division: SCKCR (ICKE0]) System clock (ICLK)
" *— 12 - 120 (MHz)
x -
7| Main clock ) ) I SCKCR (PCKA[3:0]) Peripheral madule clack (PCLKA)
. Frequency Multiplication: ® sz - 120 (MHz)
Oscillation source: | Resonator B %10.0 -
N SCKCR (PCKB[3:0]) Peripheral madule clack (PCLKB)
v 3
Frequency: 24 [MHz) P — x4 - 60 (MHz)
Oscillation wait time: SCKCR (PCKCE0N) Peripheral module clock (PCLKC)
9080 {us) (Actual valus: 10000) |—8 wiid - 50 (MHz)
SCKCR (PCKD(3:0]) Peripheral module clock (PCLKD)
— x14 - 60 (MHz)
Sub-clock SCKCR (BCK[3:0]) External bus clock (BCLK)
*— x12 - 120 (MHz)
BCKCR (BCLKDIV)
—
SCKCR2 (UCK[Z0])
HOCO dock [
. CKOCR (CKODIVI2:0]) CLKOUT pin
x1 -
LOCO clock
CANMCLE/CACMCLK
24 (MHz)
WD T-dedicated clock |
Overview | Board ICIocksl System | Components | Pins | Interrupts
H & 3
Figure 4-4 The ‘Clocks’ tabbed page
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Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

4.5

The ‘System’ tabbed page

Set the On-chip debug setting mode on the ‘System’ tabbed page.

[

System configuration 0

Generate Code Generate Report

= On-chip debug setting

Debug interface setting

{® Unused (JFINE (IITAG (O ITAG (Trace)

Overview | Board CIDcksISystemIComponents Pins | Interrupts

=

4.51

Figure 4-5 The ‘System’ tabbed page
On-chip debug

The On-chip debug settings set the interface used for debugging. For the RSK+RX671 CPU board, select

JTAG as

shown in Figure 4-6.

= On-chip debug setting
Debug interface setting

() Unused () FINE (@UTAG (O ITAG (Trace)

Mote: The using of PC7/UB may have a limitation, because PC7/UB is controlled for mode-settings by emulator.

Figure 4-6 Debug interface setting
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

4.6 The ‘Components’ tabbed page

Drivers and middleware are handled as software components in Smart Configurator. The ‘Components’ page
allows the user to select and configure software components.

Software component configuration

Components = }:& *  Configure
W
|t3-|;e-'ilter text |
w = Startup
 [= Generic
& rbsp

Overview | Board | Clocks S}rstem Pins | Interrupts

Figure 4-7 Components page

4.6.1 Add a software component into the project

Smart Configurator supports five types of software components: Startup, Drivers, Middleware, Application and
RTOS. In the following sub-sections, the reader is guided through the steps to configure the MCU for a simple
project containing interrupts for switch inputs, timers, ADC and a SCI by component of Drivers.

Click the ‘Add component’ W icon.

Software component configuration
Components =] :’.f:p »* Con
[&]
|ty|:e"i|tertes-:t |
v (= Startup
w [= Generic
& rbsp

Figure 4-8 Add a Software component (1)

In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’.

e’ New Component

Software Component Selection tlj

Select component from those available in list

Category |All ~

Function Al
Filter
iddleware
Application

Compon{RTOS
H &-Bit Timer Code Generator 1.8.0

Figure 4-9 Add a Software component (2)
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4. Smart Configurator Using the e? studio

4.6.2 Compare Match Timer

CMTO will be used as an interval timer for generation of accurate delays. CMT1 and CMT2 will be used as
timers in de-bouncing of switch interrupts.
Select ‘Compare Match Timer’ as shown in Figure 4-10 below then click ‘Next'.

e’ New Component

Software Component Selection

Select component from those available in list

Category | Drivers

Function |All ~
Filter |

Components . Type Version 2

HH 5-Bit Timer Code Generator 1.80

 Buses Code Generator 1.8.0

8 Clock Frequency Accuracy Measurement Circuit Code Generator 1.8.0

3 Compare Match Timer Code Generator 2.1.0 I

ECDmpIementary PWM Mode Timer Code Generator 1.8.0

## Continuous Scan Mode S12AD Code Generator 111.0

8 CRC Calculator Code Generator 1.8.0

## Data Operation Circuit Code Generator 1.9.0

8 Data Transfer Controller Code Generator 1.8.0

## Dead-time Compensation Counter Code Generator 1.2.0 v

Show only latest version
Hide items that have duplicated functionality

Description

This software component generates two units (unit 0, unit 1) of an on-chip &-bit timer (TMR) medule
that comprise two &-bit counter channels, totaling four channels.

Download more software components

Configure general settings...

® < Back

Mext> || Einish

Cancel

Figure 4-10 Select Compare Match Timer
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘CMTO’ as shown in Figure 4-11
below.

e New Component

Add new configuration for selected p t |
Compare Match Timer
Cenfiguration name: |Can|g_CMTWO |
Resource: CMTWO ~
CMTWO
CITW1
CMT1
CMT2
CMT3

Figure 4-11 Select Resource - CMTO

Ensure that the ‘Configuration name’ updates to ‘Config_ CMTOQ’ as shown in Figure 4-12 below then click
‘Finish’.

e New Component

Add new config for sel d p E
Compare Match Timer
Configuration name: ICanig_CMTﬁ I
Resource: iCMTO g

Figure 4-12 Ensure Configuration name - CMTO0

In ‘Config_ CMTQ’, configure CMTO as shown in Figure 4-13. This timer is configured to generate a high

priority interrupt every 1ms. We will use this interrupt later in the tutorial to provide an API for generating high
accuracy delays required in our application.

LETEITES %[5l # 5p v Configure
% W Count clock setting
[type filter text | @® PCLK/B (O PCLK/32 (O PCLK/128 (O PCLK/512
w [= Startup ~ Compare match setting
v ‘?_?”e”c Interval value |1 I Ims VI (Actual value: 1)
& rbsp
v (= Drivers Register value (CMCOR) [7429 |
veE Tllners [#] Compare match interrupt (CMI0)
& Config_CMT0
Priority |iievel 10 vI

Figure 4-13 Config_CMTO setting
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’

Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT1’ as shown in Figure 4-14 below.

e New Component

Add new config ion for sel d

Compare Match Timer

Configuration name: | Config_CMTWo

Resource: CMTWo

CMTWO
CMTW1
CMTO

® < Back Next >

o
Figure 4-14 Select Resource — CMT1

Ensure that the ‘Configuration name’ updates to ‘Config_CMT1’ as shown in Figure 4-15 below then click
‘Finish’.

e’ Mew Component

Add new configuration for selected component

Compare Match Timer

Configuration name: IConﬂg,CMﬁ I

Resource: LMT1

® < Back Next >

s

Figure 4-15 Ensure Configuration name — CMT1

Navigate to the ‘Config_ CMT1’ and configure CMT1 as shown in Figure 4-16. This timer is configured to

generate a high priority interrupt after 20ms. This timer is used as our short switch de-bounce timer later in
this tutorial.

Components = 2 = Configure
* w Count clock setting
type filter text | O PCLK/E (@) PCLK/32 O PCLK/ 128 (O PCLK/512
w [= Startup ~ Compare match setting
v (?_?”e”c Interval value IZO I Ims VI (Actual values 20)
o rbsp
w 2= Drivers Register value (CMCOR) |3?499 |
ve 'I.'_i.mers [ Compare match interrupt (CMI1)
& Config_CMTO
& Config CMT1 Priority [Level 10 VI

Figure 4-16 Config_CMT1 setting
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Compare Match Timer’ then click ‘Next’. In ‘Add new configuration for selected component’ dialog ->
Resource, select ‘CMT2’ as shown in Figure 4-17 below.

e New Component

Add new config

for sel 4

Compare Match Timer

Configuration name:

Resource:

Config_CMTWo

CMTWo

CMTWO
CMTW1
CMTO
CMT1

CMT3

® < Back Next > Cancel

Figure 4-17 Select Resource — CMT2

Ensure that the ‘Configuration name’ updates to ‘Config_CMT2’ as shown in Figure 4-18 below then click
‘Finish’.

e New Component

Add new configuration for selected p t |
Compare Match Timer
Cenfiguration name: ICanig_CMTZ I
Resource: CMT2 (R
® < Back Next > Cancel

Figure 4-18 Ensure Configuration name — CMT2

Navigate to the ‘Config_ CMT2’ and configure CMT2 as shown in Figure 4-19. This timer is configured to
generate a high priority interrupt after 200ms. This timer is used as our long switch de-bounce timer later in
this tutorial.

Components o | 2 > Configure
= Count clock setting
|t},|3e Hilter text | O PCLK/B (O PCLK/32 (O PCLK/128 ® PCLK/512
w [= Startup ~ Compare match setting
V& (.._l_f?neric Interval value IZ{)O I Ims VI (Actual value: 200.004267)
& rbsp
w = Drivers Register value (CMCOR) |2343? |
Ve 'I.'_i.mers [#] Compare match interrupt (CMI2)
& Config_CMTO
* Config_CMT1 Priority IELE\JEI 10 VI
& Config CMT2

Figure 4-19 Config_CMT2 setting
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4. Smart Configurator Using the e? studio

4.6.3 Interrupt Controller

Referring to the RSK+ schematic, SW1 is connected to IRQ9(P91) and SW2 is connected to IRQ10(P92).
SW3 is connected to IRQ15(P07) and ADTRGON. This tutorial uses ADTRGOnN, which will be configured later

in §4.6.7.

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’
Select ‘Interrupt Controller’ as shown in Figure 4-20 then click ‘Next'.

Software Component Selection
Select component from those available in list 'Hj
Category IDrwers ~ I
Function | All w
Filter | |
e
Components Type Version &
## 12C Master Mode Code Generator 1100
## 12C Slave Mode Code Generator 1.8.0
# Interrupt Controller Code Generator 2.1.0 I
8 Low Power Consumption Code Generator 21.0
H# Normal Mode Timer Code Generator 1.10.0
8 Phase ‘Counting Mode Timer Code Generator 220
## Port Output Enable Code Generator 1.8.0
B Ports Code Generator 220
s Programmable Pulse Generator Code Generator 150

# PWM Mode Timer

-

Code Generator 1100

Show only latest version
Hide items that have duplicated functionality
Description

Interrupt Controller configures the interrupt requests generated by ICL: Software interrupt, NMI pin
interrupt and IRQ External pin interrupts.

Download more software components

Configure general settings...

® < Back I Mext > I I Finish | Cancel

Figure 4-20 Select Interrupt Controller

In ‘Add new configuration for selected component’ dialog -> Resource, select ICU’ as shown in Figure 4-21

below then click ‘Finish’.

e New Component

Add new configuration for selected p t |

Interrupt Controller

Configuration name: | Config_ICU ‘

Resource: Iy ~

® < Back Next > Cancel
Figure 4-21 Select Resource — ICU
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Navigate to the ‘Config_ICU’, configure these two interrupts as falling edge triggered as shown in Figure 4-22

below.

Components

1% 5w

[type filter text

w (= Startup
v (= Generic
& rbsp
~ [ Drivers
v [= Interrupt
& Config ICU
~ (= Timers
& Config_CMTo
& Config CMT1
& Config_CMT2

Configure

Software interrupt setting
[ Software interrupt

[ Software interrupt 2

Priority

NMI pin interrupt setting
[ WM pin interrupt

IRQO setting
[JIrco

IRQ1 setting
Irat

IRQ2 setting
JIrRgz

IRQ3 setting
iraz

IRQ4 setting
[JIrRG4

IRQS setting
[JIRQs

IRQS setting
Cirae

IRQ setting
ira?

IRQ& setting
Cirae

IRQ9 setting

Eras

IRQ10 setting
Eran

IRQ11 setting
[JIran

IRQ12 setting
iraiz

IRQ13 setting
[JIrQiz

IRQ14 setting
IrQia

IRQ1S setting
Oirais

Detection type

Detection type

PFriority

Detection type

Friarity

Detection type

PFriority

Detection type

Priority

Detection type

Priority

Detection type

PFriority

Detection type

Printity

Detection type

Priority

Detection type

Pririty

Detection type

Priority

Detection type

Priarity

Detection type

PFriority

Detection type

Friarity

Detection type

Priority

Detection type

Priority

Detection type

Priority

Level 15 (highest)

Falling edge

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Falling edge ~
Level 15 (highest) ~

Level 15 (highest) v

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Low level

Level 15 (highest)

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Digital filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

Mo filter

=

=

(KMHz)

(MHZ)

(MHz)

(MHZ)

(MHz)

(MHz)

(MH2Z)

(KMHz)

(MHZ)

(KMHz)

(MHZ)

(KHz)

(MHZ)
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(MH2Z)
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Figure 4-22 Config_ICU setting

R20UT4885EG0100 Rev. 1.00

May.10.21

RRENESAS

Page 24 of 66



Renesas Starter Kit+ for RX671
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4.6.4 Ports

Referring to the RSK+ schematic, LEDO is connected to P17, LED1 is connected to PF5, LEDZ2 is connected
to PO3 and LED3 is connected to P05. PJ3 is used as one of the LCD control lines, together with P74, P71

and P72.

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’

Select ‘Ports’ as shown in Figure 4-23 then click ‘Next'.

= New Component

Software Component Selection

Select compenent from those available in list

Category IDrivErs

Function | All w
Fiter | |
=

Components Type Version &
## Phase Counting Mode Timer Code Generator 220

## Port Output Enable Code Generator 1.9.0
IB Ports ‘Code Generator 220 I
## Programmable Pulse Generator Code Generator 150

## PWM Mode Timer Code Generator 1100

8 Real Time Clock Code Generator 160

## Remote Control Signal Receiver Code Generator 1.1.0

# 5CI/SCIF Asynchronous Mode Code Generator 1.10.0

8 5CI/SCIF Qlock Synchronous Mode Code Generator 1.10.0

## Single Scan Mode S12AD Code Generator 230 v
e R - -

Show only latest version
Hide items that have duplicated functionality

Description

This software component provides configurations for General Purpose Input/Output. Common features
such as reading, writing, and setting the direction of ports and pins can be configured. Enabling
features such as open-drain cutputs and internal pull-ups are also supported.

Download more software components

Configure general settings...

® < Back I

Mext >

|1 Enish || Cancel

Figure 4-23 Select Ports

In ‘Add new configuration for selected component’ dialog -> Resource, select ‘PORT’ as shown in Figure 4-24

below then click ‘Finish’.

e New Component

Add new configuration for selected component

Ports
Configuration name: | Config_PORT
Resource: PORT

® < Back

Mext >

Cancel

Figure 4-24 Select Resource — PORT
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Renesas Starter Kit+ for RX671 4. Smart Configurator Using the e? studio

Tick the tickboxes for ‘PORTQ’, ‘PORT1’, ‘PORT7’, ‘PORTF’ and ‘PORTJ’ as shown in Figure 4-25 below.

Components = 2 »  Configure
W o Portselection  PORT0O PORT1 PORT7 PORTF PORT)
|'.~,-|:e filter text |
v [= Startup
v [ Generic [E2rorTo] [E1rorTi]
& rbsp
w = Drivers [JPORT2 CJPORT2
v [= Interrupt
& Config_ICU []PORT4 []PORTS
v = IfO Poris
& Config_PORT [1PORTa PORT7
w = Timers
& Config_CMTo [1PORTE [C1PORTS
& Config_CMT1
& Config_CMT2 [JPORTA CJPoRTE
[drorTC [JrORTD
[JPORTE PORTF
[JPORTH

Figure 4-25 Select Port selection

Navigate through each of the 'PORTX' tabs, configuring these four 1/O lines and LCD control lines as shown in
Figure 4-26, Figure 4-27, Figure 4-28, Figure 4-29 and Figure 4-30 below. Tick the tickboxes for ‘Out’ and
tick ‘Output 1’ the tickboxes except for P72 under the ‘PORT7’ tab. Start with the 'PORTOQ' tab.

Components = 2 = Configure 1
L Port selection | PORTO | PORT1 PORT7 PORTF PORTJ
type filter text |
v & Starup [l Apply to al
w = Generic PR
& rbsp Unused GPIO In Out Pull-up CMOS output Output 1
w == Drivers
~ [= Interrupt PoOO
@ Config_ICU @ Unused GPI0 Ciin O 0out [JPull-up | CMOS output ~ Output 1 Normal drive cutput
w &= I/O Ports
& Config_PORT PO
w = Timers
w_—- Config CMTo @®UnusedGPIC Oin Oouwt O Pull-up CMOS output ~ Output 1 Normal drive output
& Config_CMT1
@ Config_CMT2 Poz
@ Unused GPIO Oin - O 0ut  JPull-up CMOS output ~ Output 1 Mormal drive output
Poz
OUnused GPIO. O'n Pull-up  |CMOS output | Eoutput 1
Pos
OUnused GPI0. Oln Pull-up  [CMOS output «| Eloutput 1
Po7
@®Unused GPIC O'In - (O Out I:‘Pull-up CMOS output ~ Output 1
Figure 4-26 Select PORTO0 tab
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Select ‘PORT1’ tab.

Components o | 2 = Configure @
% S Port selection PORTO| PORT1 | PORT7 PORTF PORTJ
|type"i|te|‘ text |
v & Startup [ Apply to all
w = Generic PRy
@& rbsp Unused GPIO In Out Pull-up CMOS output Output 1
w [= Drivers
w = Interrupt P12
& Config_ICU ®UnusedGPIO O'In - O0Out  [JPull-up | CMOS output ~ Output 1 Normal drive output
v [= /O Ports
& Config_PORT P12
v [= Timers o
& Config CMTo ®UnusedGPIO Oin - O0ut  [JPull-up | CVOS output ~ Output Normal drive output
@& Config_CMT1
@ Config_CMT2 P4
® UnusedGPIO Oin O 0wt [JPull-up CMOS output w~ Output 1 Normal drive output
P15
®UnusedGPIO OIn - O0Out  [JPull-up | CMOS output ~ Output 1
P16
® UnusedGPIO Oin O 0wt [JPull-up CMOS output ~ Output 1
P17
O Unused GPIO Oin Pull-up | CMOS output ~ High-drive output
Figure 4-27 Select PORT1 tab
Select ‘PORT7’ tab.
Components 4 = 3 v Configure o
J‘ L Port selection PORT0 PORT1 | PORT7 | PORTF  PORT)
|t}-pe"ilter text |
w [= Startup 0
Apply to all
w = Generic PRy
& rbsp Unused GPIO In Out Pull-up CMOS output Output 1
w == Drivers
~ [ Interrupt P70
& Config_ICU ®UnusedGPI0 OIn - O0Out  [JPull-up | CMOS output v Output High-drive output
v = /O Ports
& Config_PORT -
w (= Timers
& Config MTo OUnused GPI0 Ol Pull-up | CMOS output v
& Config_CMT1
& Config_CMT2 p72
O Unused GPIC (D) In Pull-up CMOS output v O Output 1 Mormal drive cutput
P73
@ Unused GPIO O'In - O 0wt [JPull-up CMOS output ~ Cutput 1 High-drive output
P74
O Unused GPIO OIn Pull-up CMOS output w Normal drive output
P75
®Unused GPIO Oin - O 0wt [JPull-up CMOS output ~ Output 1 Normal drive output
P7E
@ Unused GPIO. O'n O 0wt [JPull-up CMOS output ~ Output 1 Mormal drive output
P77
®UnusedGPI0 OIn O0ut  [JPull-up | CMOS output v Output 1 Normal drive output
Figure 4-28 Select PORT7 tab
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Select ‘PORTF’ tab.

Components = 2 = Configure

| type filter text

v [= Startup
w = Generic
@& rbsp
w [z= Drivers
v [= Interrupt
& Config_ICU
w = I/O Ports
& Config_PORT
w = Timers
& Config_CMTo
@ Config_CMT1
@ Config_CMT2

Port selection PORT0O PORT1 PORT7 | PORTF | PORT)

I Apply to all
Unused GPIO In Out Pull-up CMOS output Cutput

PF5

OUnused GPIO. O'n Pull-up | CMOS output v

Select ‘PORTJ’ tab.

Figure 4-29 Select PORTF tab

Components =

H

-

| type filter text

w [= Startup
w = Generic
@ rbsp
w = Drivers
w [= Interrupt
@ Config_ICU
v [= I/O Ports
& Config_PORT
w = Timers
@ Config_CMTO
@ Config_CMT1
& Config_CMT2

Configure

Port selection  PORTO PORT1 PORT7 PORTF | PORT

I apply to all
Unused GPIO In Out Pull-up CMOS output Output 1

P13

OUnused GPIO. Ol Pull-up | CVIOS output v

PJs
® Unused GPIO Oiin (O Out Dpull-up CMOS output ~ Output 1

Figure 4-30 Select PORTJ tab
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4.6.5 SCI/SCIF Asynchronous Mode
In the RSK+RX671, SCI10 is connected via a Renesas RL78/G1C to provide a USB virtual COM port as
shown in the schematic.

Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘SCI/SCIF Asynchronous Mode’ as shown in Figure 4-31 then click ‘Next'.

e’ New Component

Software Component Selection
Select component from those available in list E
Category IDrivers VI
Function | All v
Filter | |
Compenents Type Version @
8 Real Time Clock Code Generator 1.60
## Remote Control Signal Receiver Code Generator 1.1.0
o SCI/SCIF Asynchronous Mode Code Generator 1100 ]
8 5CI/SCIF Clock Synchronous Mode Code Generator 1.10.0
8 Single Scan Mode S12AD Code Generator 23.0
2 Smart Card Interface Mode Code Generator 1.10.0
# 5Pl Clock Synchronous Mode (3-wire method) Code Generator 1.10.0
#spl Operation Mode (4-wire method) Code Generator 1.80
BVD\laqe Detection Circuit Code Generator 1.9.0
# Watchdog Timer Code Generator 1.9.0 v

Show only latest version
Hide items that have duplicated functionality

Description

This software component provides configurations for SCI(SCIF) single{multi-processor) asynchronous
mode.

Download more software components

Configure general settings...

® = Back I Next > I I Einish I Cancel

Figure 4-31 Select SCI/SCIF Asynchronous Mode

In ‘Add new configuration for selected component’ dialog -> Work mode, select ‘Transmission/Reception’ as
shown in Figure 4-32 below.

¢ New Component

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCI0

‘Work mode: Transmission ~

Resource:

ception
Transmission
Multi-processor Reception
Multi-processor Transmission/Reception

Figure 4-32 Select Work mode — Transmission/Reception
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In ‘Resource’, select ‘SCI10’ as shown in Figure 4-33 below.

e’ New Component

Add new configuration for selected component -E-

SCI/SCIF Asynchronous Mode

Configuration name: | Config_SCIO

Work mode: Transmission/Reception -

Resource: SClo ~

sClo
5Ch
sCiz
sCi2
SCI4
SCls
5Cle
sci7
sCle
]

SCh1
SChz

@ < Back Next > Cancel
Figure 4-33 Select Resource — SCI10

Ensure that the ‘Configuration name’ updates to ‘Config_SCI10’ as shown in Figure 4-34 below then click
‘Finish’.

&' New Component

Add new configuration for selected component 'Ha'
SCI/SCIF Asynchronous Mode
Configuration name: IConfig_SCI‘IO I
Work mode: Transmission/Reception -
Resource: 5CI0 S
® < Back MNext = Cancel

Figure 4-34 Ensure Configuration name - Config_SCI10
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Configure SCI10 as shown in Figure 4-35. Ensure the ‘Start bit edge detection’ is set as ‘Falling edge on
RXD10 pin’ and the ‘Bit rate’ is set to 19200 bps. All other settings remain at their defaults.

Components = 2 = Configure
W FIFO mode setting
|'—‘;'ISE filter text | (® Non-FIFO mode (O)FIFQ mede
w = Startup Start bit edge detection setting
~ [ Generic (O Low level on RXD10 pin I@Falling edge on RXD1DpinI
& rbsp i
v (& Drivers Data length setting
v (& Interrupt () 9 bits (®) B bits (D)7 bits
. BT'GCPD;;?_ICU Parity setting
N E Odd
& Config_PORT ® Nane Ofven ©
v = Colnmunications Stop bit length setting
& Config_SC0 @1 bit () 2 bits
w = Timers
& Config CMT0 Transfer direction setting
& Config CMT1 (®) LSB-first () MSB-first
. Config_CMT2
® 8- Data inversicn setting
(®) Mormal (O Inverted
Instant transmission setting
[]Enable instant transmission
Transmitter cutput setting
(®) Mormal (O Inverted
Receiver input setting
(@ MNormal (O Inverted
Transfer rate setting
Transfer clock Internal clock ~
Base clock 16 cycles for 1-bit period -
Bit rate |19200 VI (bps) (Actual value: 19230.769, Error: 0.16%)
[JEnable medulation duty correction
SCK10 pin function SCK10is not used ~
Transfer timing adjustment setting
[ Adjust transmit signal transition Does not change the waveform
[ Adjust receive data sampling 3 clocks later than default point
Moise filter setting
[ Enable noise filter
Clock signal divided by 1 120000000
Hardware flow control setting
@ None OcTsi0 CIRTS102
15
FIFO data setting
o
8
Data match detection setting
[[Enable data match detection
000
Data handling setting
Transmit data handling Data handled in interrupt service routine ~
Receive data handling Data handled in interrupt service routine ~
Interrupt setting
TXNO pricrity Level 15 (highest) ~
RXI0 priority Lewvel 15 (highest) ~
Enable reception error interrupt (ERI10)
TENG, ERNO priority (Group ALD) Level 15 (highest) ~
Receive data ready interrupt Receive data full interrupt (RXI)
Callback function setting
Transmissicn end Reception end Reception error
Figure 4-35 Config_SCI10 setting
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4.6.6 SPI Clock Synchronous Mode

In the RSK+RX671, SCI6 is used as an SPI master for the Pmod LCD on the PMOD1 connector as shown in

the schematic. Click the ‘Add component’ & icon. In ‘Software Component Selection’ dialog -> Type, select
‘Drivers’. Select ‘SPI Clock Synchronous Mode’ as shown in Figure 4-36 then click ‘Next'.

e’ New Component

Software Component Selection

Select component from those available in list

Category IDrwer;

Function |All ~
Filter | |
Components - Type Version 2

H# Real Time Clock Code Generator 160

8 Remote Control Signal Receiver Code Generator 1.1.0

® SCI/SCIF Asynchronous Mode Code Generator 1100

8 SCI/SCIF Clock Synchronous Mode Code Generator 1.10.0

i Single Scan Mode S12AD Code Generator 230

## Smart Card Interface Mode Code Generator 1.10.0

2 SPI Clock Synchronous Made (3-wire method) ‘Code Generator 1.10.0 |
E SPI Cperation Mode (4-wire method) Code Generator 1.8.0
B\'oltage Detection Gircuit Code Generator 1.8.0

8 Watchdog Timer Code Generator 1.8.0 =

Show only latest version
Hide items that have duplicated functionality

Description

This component provides clock synchronous operation of RSPl or SCI (Simple SP1 bus). It includes 4
transfer modes: Slave transmit/receive, Slave transmit, Master transmit/receive and Master transmit.

Download more software compenents

Configure general settings...

® < Back I

Next >

Eiish | Cancel

Figure 4-36 Select SPI Clock Synchronous Mode

In ‘Add new configuration for selected component’ dialog -> Operation, select ‘Master transmit only’ as shown

in Figure 4-37 below.

e New Com

Add new configuration for selected component

SPI Qlock Synchronous Mode (3-wire method)

Configuration name: | Config_RSPIO

Operation: Slave transmit/receive

Slave transmit/receive
Slave transmit cnly
Slave receive only

Resource:

Master tra nsmlﬁrec (=

@ < Back

Next >

Cancel

Figure 4-37 Select Operation — Master transmit only
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In ‘Resource’, select ‘SCI6" as shown in Figure 4-38 below.

e’ New Component

Add new configuration for selected component -E-

SPI Clock Synchronous Mode (3-wire method)

Configuration name: | Config_RSPI0

Operation: Master transmit cnly -

Resource: RSPIO ~

RSPIO
RSPI1
RSPIZ
SClo
sCh
SCIz
sSClz
SCl4
SCIs
SCI7
sCla
SCla
sCho
SCh
sChz

@ < Back Next > Cancel
Figure 4-38 Select Resource — SCI6

Ensure that the ‘Configuration name’ updates to ‘Config_SCI6’ as shown in Figure 4-39 below then click
‘Finish’.

e’ New Component

Add new configuration for selected component -E-
SPI Clock Synchronous Mode (3-wire method)
Configuration name: ICanig_SCIS I
Operation: Master transmit cnly -
Resource: 5Cle R
® < Back MNext = Cancel

Figure 4-39 Ensure Configuration name - Config_SCI6
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Configure SCI6 as shown in Figure 4-40. Ensure the ‘Transfer direction’ is set as ‘MSB-first’ and the ‘Bit rate’

is set to 15000 kbps. All other settings remain at their defaults.

Components = :{=:{> ~  Configure
W n Transfer direction setting
|'.',-pe filter text | () LSB-first (®) MSB-first
Starb
v & Startup . Data inversion setting
w22 Generic
& rbsp (® MNormal O Inverted
w 2= Drivers
v (& Interrupt Transfer speed setting
@ Config ICU Transfer clock Internal clock (SCK6 pin functions as clock output pin)
v [= I/O Ports

w = Communications

= o [ Enable modulation duty correction
& Config_5Ch0

£

& Config_PORT Bit rate (kbps)  (Actual value: 15000, Error 0%)

& Config_SCI6 Clock setting
v [= Timers o .

& Config_CMTO [ Enable clock delay [JEnable clock polarity inversion

& Config_CMT1 Data handli

'f' Config_CMT2 ata handling setting
Transmit data handling Data handled in interrupt service routine ~
Interrupt setting
TXIE pricrity Level 15 (highest) ~
TEI6 pricrity (Group BLO) Level 15 (highest) ~
Callback function setting
[ Transmission end

Figure 4-40 Config_SCI6 setting
R20UT4885EG0100 Rev. 1.00 RENESAS Page 34 of 66

May.10.21



Renesas Starter Kit+ for RX671

4. Smart Configurator Using the e? studio

4.6.7 Single Scan Mode S12AD

We will be using the S12AD in Single Scan Mode on the ANO0OO input, which is connected to the RV1
potentiometer output on the RSK+. The conversion start trigger will be via the pin connected to SW3. Click

the ‘Add component’ % icon. In ‘Software Component Selection’ dialog -> Type, select ‘Drivers’. Select
‘Single Scan Mode S12AD’ as shown in Figure 4-41 then click ‘Next'.

e’ New Component

Software Component Selection
Select component from those available in list Hj
Category IDrivErs VI
Function | All ~
Filter ‘ |
Components Type Version "
8 Real Time Clock Code Generator 160
8 Remote Control Signal Receiver Code Generator 1.1.0
8 SCI/SCIF Asynchronous Mode Code Generator 1.10.0
8 SCI/SCIF Clock Synchronous Mode Code Generator 1.10.0
 Single Scan Mode 512AD Code Generator 2.3.0 |
8 Smart Card Interface Mode Code Generator 1.10.0
# 5PI Qlock Synchronous Mode (3-wire method) Code Generator 1.10.0
i spl Operation Mode (4-wire method) Code Generator 1.8.0
EVoltage Detection Circuit Code Generator 1.8.0
## Watchdog Timer Code Generator 18.0 v

Show only latest version
Hide items that have duplicated functicnality

Description

This software component provides single scan mode configurations for 12-Bit A/D Converter which the
analog inputs arbitrarily selected are converted for only once in ascending channel order.

Download more software components

Configure general settings...

® < Back I Mext » I | FEinish I Cancel

Figure 4-41 Select Single Scan Mode S12AD

Ensure that the 'Configuration name' is'Config_S12AD0' as shown in Figure 4-42 below then click ‘Finish’.

e New Component

Single Scan Mode S12AD

Configuration name: | Config_S12AD0

Resource: S12AD0 ~

Figure 4-42 Ensure Configuration name - S12AD0
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Configure S12ADO0 as shown in Figure 4-43 and Figure 4-44. Ensure the ‘Analog input channel’ tick box for
ANO0O0O is checked and the ‘Start trigger source’ is set to ‘A/D conversion start trigger pin’. All other settings
remain at their defaults.

Compone... = :%{:> =

| type filter text

w = Startup
v [2= Generic
& rbsp
w 2= Drivers
~ [ Interrupt
@ Config_ICU
v [= A/D Converter
& Config_S12A00
v [= /O Ports
& Config_PORT
v 2= Communicaticns
& Config_SCI10
& Config_5Cl6
v (2= Timers
@ Config CMTo
@ Config CMT1
@ Config CMT2

Basic setting

Note

When using the 12-bit A/D cenverter unit 0, do net use the P40to P47, P03, P05, and POT pins as output pins,
We also recommend not using the P00 to P02, Pan, PDO to PD7, PEO, and PE1 pins as cutput pins.

Anazleg input channel setting

EJanon ] ANoo1
[JANDOS 1 ANDDG

Conversion start trigger setting

[ aNooz [RFE
[ ANoo7

] Anoog

Start trigger source

IA»'D conversion start trigger pin

Interrupt setting

Enable AD conversion end interrupt (512AD1) Priority Level 15 (highest)

A setting

Add/Average AD value setting

ANODD4

] ANooo ANODD1 ANoo2 AMNDO3
ANOOS ANODE AMNOO7

Self diagnosis setting

Mode Unused
ov

Disconnection detection assist setting

Charge setting Unused
2 ADCLK

Figure 4-43 Config_S12AD0 setting (1)
RENESAS
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Data registers setting

Data placement

Automatic clearing
Conversion resolution
Addition/Average mode select

Addition count

Window function setting
(®) Disable

Window A/B operation setting

[JEnable comparison window A

Window A/B complex condition

A/D comparison A setting

Reference data O for comparison

Reference data 1 for comparison
Use comparator for ANODO

or for ANOO1

r for AN0OZ
or for ANDO3
or for ANOD4
or for ANDDS
r for ANODG

Use comparator for ANOOT

A/D comparison B setting
Reference data Jfor comparison
Reference data 1 far comparison

Carnparizan B channel

Input sampling time setting
AMN000/Self-diagnesis
AN

AN

AN

AR

ARG

ANKIGE

ANIT

Interrupt setting

Enable AD conversion compare interrupt A (S12CMPAL)

Group BLT priority

Right-alignment

Disable automatic clearing

12-bit accuracy
Addition mode

1-time

() Enable

[JEnable comparison window B

Window A comparison condition matched OR window B comparison condition matched

0

0

Reference data 0 > A/D-converted value

=}
I

Reference data

A/D-converted value

Reference data 0 > A/D-converted value

=}
=

Reference data

> AfD-converted value

Reference data 0 > A/D-converted value

[=1

Reference data

=

Reference data

> A/D-converted value

> A/D-converted value

Reference data 0 > A/D-converted value

0
0

Unused

Reference data 0 > A/D-converted value

0.183

(Total conversion time: 0.567us)

Level 15 (highest)

(us)
[nsh
(us)
(us)
(us)
(us)
(us)

(us)

(Actual value: 0,183)
[Actual value: 0.183)
[Actual value: 0.153)
[Actual value: 0.153)
[Actual value: 1.183)
[Actual value: 0.153)
[Actual value: 0.153)
[Actual value: 1.183)

Enable AD conversion compare interrupt B (S12CMPEBI)

Figure 4-44 Config_S12AD0 setting (2)
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4.7 The ‘Pins’ tabbed page

Smart Configurator assigns pins to the software components that are added to the project. Assignment of the
pins can be changed using the Pins page.

Pin configuration

Hardware Resource = 1% )

|T-,-pe:i|:er text |
2 Al ~

#f Clock generator

{%. Clock frequency accuracy measurement circuit

#f Operating mode control
ﬁ; System control

#F Interrupt controller unit

v 7 Multi-function timer pulse unit 3

MTUo

MTL

MTUZ2

MTU3

MTU4

MTUs

MTU&

MTU7 v

Pin Function Pin Number

Overview | Board | Clocks | System Componentslnterrupts
Figure 4-45 The ‘Pins’ tabbed page

4.71 Change pin assignment of a software component

To change the pin assignment of a software component in the Pin Function list, click 52 to change view to
show by Software Components.

Pin configuration

Hardware Resource = la

|T-J-|:e filter text |

Figure 4-46 Change view to show by Hardware Resource
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Select the Config_ICU of Software Components. In the Pin Function list -> Assignment column, change the
pin assignment IRQ9 to P91, IRQ10 to P92. Ensure the ‘Enable’ tick box of IRQ9 and IRQ10 are checked, as
shown in Figure 4-47.

Software Components = |% &% Pin Function =l | ‘ =] | T |
Type filter text | |'.',-|:e filter text (* = any string, ¥ = any character) | All ~
v 5 rbsp Enabled  Function Assignment Pin Number DCirection Remarks 2
o #-.Col::sasrel\ﬂatch Timer [} IRC0 4 Not ass!gned # Mot ass!gned MNone

b ~ 1 IR # Mot assigned # Mot assigned  Mone
" Con"!g_CMTD O IRQ2 # Mot assigned # Mot assigned  MNone
" CDHT!Q‘CMH O IRQ3 # Mot assigned # Mot assigned Mone
-!-'.I CDn_IgECMTZH O IRC4 # Mot assigned # Motassigned Mone
~ i nterrup_t ontroller O IRQ5 # Not assigned # Notassigned None
v #‘.gor(s:nilg,ICU 1 IRGE # Mot assigned # Mot assigned  Mone
".(,, Config_PORT | IRQ7 # Mot assigned # Motassigned  Mone
- & St\»'SCIF ,Brswnchronousl\n‘lode [l IROa # Mot assigned # Mot assigned  Mone
ww T IRG9 L7 _Pot/A1T/SCKT/IRAS 17 129 |
v B S o o tvoreats ek (5 wie RQ10 [ To2/ATe/POE 4 RXDSMISO /SR ] # 128 |
- o O IRQ11 # Mot assigned # Mot assigned  MNone
g_‘ts'_ C;:vn;cg_SIﬂIE des O IRQ12 # Mot assigned # Motassigned Mone
Ml B an Mode 51240 O IRQ13 # Not assigned # Notassigned MNone
& Config S12AD0 1 IRC14 # Mot assigned # Mot assigned  Mone
— IDAac P Y —— & Rls arrimmad  Blame &
< > < >
Pin Function Pin Number

Figure 4-47 Configure pin assignment - Config_ICU

Select the Config_SCI10 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of RXD10 and TXD10 are checked and Assignment column of RXD10 is P86 and TXD10 is
P87 as shown in Figure 4-48.

Software Components £ 18 5% Pin Function al | | _§ﬂ| By ey
Type filter text | |?,‘|:e filter text (* = any string, 7 = any character) | All ~
v L rbsp Enabled  Function Assignment Pin Nurmnber Direction Remarks

Hﬂhc r_bsp " . 0 CTS10# 7 Mot assigned 4 Motassigned  Mone
g O'“Pa? atch Timer O RTS10# # Not assigned # Notassigned None
W Canfig CMTO RXD10 [ Fee/MTIOCAD TIOCAG SIS0 10/ SSCLIG/RXDIG/SMI] # 41 I

n Conjg_CMT‘l 0 SCK10 7 Not assigned # MNotassigned None
™ Config CMT2 ™10 OGO O SR o O/ # 33 o
v-'.!; Interrupt Controller
@& Config_ICU
v ‘.-‘.-._ Ports
& Config_PORT
v . SC/SCIF Asynchronous Mode
i’ Config_SCI0
~ % SPI Clock Synchronous Mode (3-wire
@ Config_SCI6
v /% Single Scan Mode S12AD
@ Config_S124D0
< > < >
Pin Function Pin Number

Figure 4-48 Configure pin assignment - Config_SCI10
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Select the Config_SCI6 of Software Components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of SCK6 and SMOSI6 are checked and Assignment column of SCK6 is P02, SMOSI6 is P00

as shown in Figure 4-49.

Software Components

= |% 4% PinFunction

=
Al

Type filter text |

|?,‘|:e filter text (* =

any string, 7 = any character)

| [an

v ‘-5'; r_bsp
W rbsp
v ‘H'; Compare Match Timer
w' Config CMTo
w' Config_CMT1
w' Config_CMT2
v-'.!; Interrupt Controller
@& Config_ICU
v ‘.-‘.-._ Ports
& Config_PORT
v S SCI/SCIF Asynchronous Mode
@ Config_SCI10
v ‘,5'; SPI Clock Synchroncus Mede (3-wire
& Config_SCI6
v /% Single Scan Mode S12AD
@ Config_S124D0

£ >

| 6 | 23 e

b

Enabled
SCKe

OEOE

S56e%

Function

SMISCE
SMOSle

Assignment

Pin Mumber

L _Po2/TMCIH/SCKe/IRQ10/AN 109

# Not assigned

L _Poo/TMRIO/TXDE/ SMOSIG/SSDAG/ IRCE/ANT11

# Not assigned

|

# Not assigned
|75
# Mot assigned

Direction
[]

None

10

None

Remarks

Pin Function Pin Number

Figure 4-49 Configure pin assignment - Config_SCI6

Select the Config_S12AD0 of software components. In the Pin Function list -> Assignment column, Ensure the
‘Enable’ tick box of ADTRGO#, AN00O, AVCCO0, AVSS0, VREFHO and VREFLO are checked and Assignment
column of ANOOO is P40, ADTRGO# is P07 as shown in Figure 4-50.

Software Components = |4 &%  PinFunction d | | =] | 29 4
Type filter text | type filter text (* = any string, ? = any character) | All ~
v -"!: r_bsp Enabled  Function Assignment Pin Mumber Direction Remarks

-4'-'.12 r-bsp [ ADTRGO# [Z_PO/RQIs/ADTRGE ]7 124 |
Vi °'2Paf CT\«‘ICT fmer ANODO 7_Pa0) ROE/ANDO0 ]7 141 I
n COHL!Q_CMTU Ol ANoot # Not assigned # Mot assigned  None
n Con:g_cm‘[‘l 00 ANooz # Notassigned # Motassigned None
#‘Ill on IgE ZH | ANOOZ # Mot assigned # Motassigned MNone
v Et?m'it Ic|>:nutrc> er O ANDD4 # Notassigned # Motassigned MNone
'SL*D-. onng | ANOOS ¥ Not assigned # Motassigned None
e Horés fi0 PORT O ANoos ¥ MNot assigned # Motassigned Mone
.!‘-.* onnig O ANooO7 # Not assigned # MNotassigned Mone
w oo, SCYSCIF Asynchronous Mode
.F Config_5C110
£ ‘-4'; SPI Clock Synchronous Mode (3-wire
& Config_SCI6
v 2% Single Scan Mode S12AD
& Config_S12AD0
< > < >
Pin Function Fin Mumber
Figure 4-50 Configure pin assignment - Config_S12AD0
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Peripheral function configuration is now complete. Save the project using the File -> Save, then click
‘®elGenerate Code’ at location of Figure 4-51.

] =]

Pin configuration
g9 Generate Code | Generate Report

Figure 4-51 Generate Code Button

The Console pane should report ‘Code generation is successful’, as shown Figure 4-52 below.

& Console =k Bf E<Q| ™ ~H~-=0
Smart Configurator Output
MB4RAEBR1: File generated:srci\smc gen\Config S12ADB\Config S12ADG.c S

MB4e@BBR1: File generated:srcismc gen‘\Config S12AD8\Config S12ADB user.c
Ma4eeerBl: File generated:srcismc gen‘genersl'r cg macrodriver.h
Ma4eeeel: File generated:srcismc gen‘general\r cg userdefine.h
Ma4eeeel: File generated:srchsmc gen‘generalir smc entry.h

Ma4eeee0l: File generated:src\smc gen‘general\r cg hardware setup.c
Me4eeee0l: File generated:src)smc gen‘genersl'r cg cmt.h

Mp4peeeel: File generated:src\smc gen‘\generalhr cg cmiw.h
Ma4aeeeel: File generated:srclsmc gen'\general\r cg icu.h

Me4aeeeel: File generated:src\smc gen'general\r cg port.h

MB48BBBE1: File generated:src\smc gen\general\r cg sl2ad.h

MB48BBBE1: File generated:srcl\smc gen\general\r cg sci.h

MB4BBBBGL: File generated:src\smc gen\general\r cg rspi.h

Ma5eae012: File generated:srcismc gen\r pincfg\Pin.h

Ma5eee012: File generated:srcismc gen\r pincfg'\Pin.c

Maeeeern2: File generated:srcismc gen‘general\r smc interrupt.c
Meeeeea2: File generated:srcismc gen‘general\wr smc interrupt.h
Meseeea2: File generated:srcismc gen'r confighr bsp interrupt cenfig.h
M@aeeeee2: Code generation is successful:C:'\Workspace\SC Tutoriallsrchsmc gen
Me3e00084: File modified:src\smc gen‘\r cenfighr bsp config.h

Figure 4-52 Smart Configurator console

4.8 Building the Project

The project template created by Smart Configurator can now be built. In the Project Explorer pane expand the
‘src’ folder then smc_gen folder.

....... lﬂ] Includes
w [ src
W = smc_gen
= Config_CMT0
= Config_CMT1
= Config_CMT2
= Config_ICU
= Config_PORT
= Config_S12AD0
= Config_SCH0
= Config_SCl6
= general
= r_bsp
&= r_config
= r_pincfg
[ SC_Tutorial.c
= trash
4% SC_Tutorial.scfg
SC_Tuterial HardwareDebug.launch

Figure 4-53 Generated folder structure

FE

Switch back to the ‘C/C++’ perspective using the button on the top right of the e? studio workspace.

Select SC_Tutorial in the Project Explorer pane, then use ‘Build Project’ from the ‘Project’ menu or the
button to build the tutorial. The project will build with no errors.
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5. User Code Integration

In this section, the remaining application code is added to the project. Source files found in the RSK+ Web
Installer are copied into the workspace and the user is directed to add code in the user areas of the code
generator files.

Code must be inserted into the user code area within many Smart Configurator-generated files in this project,
these user code areas are delimited by comments as follows:

/* Start user code for xxxxx . Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Where _xxxx_ depends on the particular area of code, i.e. ‘function’ for insertion of user functions and
prototypes, ‘global’ for insertion of user global variable declarations, or ‘include’ for insertion of pre-processor
include directives. User code inserted inside these comment delimiters is protected from being overwritten by
Smart Configurator, if the user subsequently needs to use Smart Configurator to regenerate any of the Smart
Configurator-generated code.

5.1 Project Settings

e Change the optimization level of the *

. . . 1L ; Show In Alt+Shift+W »
build configuration 'HardwareDebug' bzuc-;:l‘jgjl[”a“""a’e““
before building the project. With the v s 2 Cory .
. . . Fasie Cirl+V
SC_Tutorial project selected, right- "Bg‘z—giﬂ oo X Delete Delete
. . onfig_
click and select [Properties], or use (= Config CMT1 S 5
the shortcut keys [Alt] + [Enter] to &Eon'}s_&m
open the Properties window. = et sonr Rename.. P2
(z= Config_S12AD0 Compare With ¥
(= Config 5CI0 Restore from Local History...
== Config_SCle MISRA-C >
(= general
(= rbsp §® (/C++ Project Settings Ctrl+Alt+P
= r_config Save build seftings report
= r_pincfg Change Device

[g] SC_Tutorial.c Run C/C++ Code Analysis

(= trash ~
8 SC_Tutorial.scfg [ SEEmERS
= SC_Tutorial HardwareDe @@  Command Prompt
Configure >
Properties Alt+Enter
. ‘ . . i
¢ Navigate to ‘C/C++ Build -> Settings | settings G-
->Compiler -> Optimization.
Configuration: | HardwareDebug [ Active ] ~ | | Manage Cenfigurations...
' .
e Select 'Level 0: Do not perform
s . ' . . .
optimization' from the Optimization
i Tool Settings Toolchain Device Build Steps Build Artifact Binary Parsers €3 Error Parsers
level pull-down.
v B Common Optimization level Level 2: Performs whole module optimization
& CPu [ Outputs additional information for intes Level 0: Do not pe'ﬁ”“ EHIE T
@ PIC/PID Level 1: Perform partial optimization
@ Miscellaneous Optimization type Level 2: Performs whole module optimization
v B Compiler Level max: Perform all applicable optimizations
P Perform loop optimization D

v (@ Source
(2 Advanced

(& Object
2 List —
~ (5 Optimization 100
(8 Advanced

(5 Qutput

Performs inline expansion autematically | Depends on the optimization option ~

e Press the ‘Apply and Close’ button to

close Properties window. Cancel
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5.2 LCD Code Integration

API functions for the Okaya LCD display are provided with the RSK+. Refer to the Tutorial project folder
created according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-ascii.c
-ascii.h
-r_okaya_lcd.c
-r_okaya_lcd.h

Copy these files in to the src folder below the workspace. These files will be automatically added to the

project as shown in Figure 5-1.

w =5 SC_Tutorial [HardwareDebug]
[l Includes
w [ src

= smc_gen
[ ascii.c
[ asciih
@ r_okaya_lcd.c
r_okaya_lcd.h
[€] SC_Tutorial.c

Figure 5-1 Adding files to the project

In the e? studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’ by
double-clicking on it. Insert the following #defines in between the user code delimiter comments as shown
below.

/* Start user code for macro define. Do not edit comment generated here */

#define TRUE (1)
#define FALSE (0)

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src’ folder and open the file ‘SC_Tutorial.c’ by double-clicking on it.
Add header files near the declaration #include r_smc_entry.h’.

#include "r smc entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"

Scroll down to the ‘main’ function and insert the highlighted code as shown below into the beginning of the
‘main’ function:

void main (void)

{
/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX671 ");

R LCD Display(l, (uint8 t *)" Tutorial ");

R LCD Display (2, (uint8 t *)" Press Any Switch ");
while (10U)

{

}

Indentation is lost when the code described in this manual is pasted into the e? studio source file. Also check that
the pasted code is correct.
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5.21 SPI Code

The Okaya LCD display is driven by the SPI Master that was configured using Smart Configurator in §4.5.6. In
the e? studio Project Tree, expand the ‘src\smc_gen\Config_SCI6’ folder and open the file ‘Config_SCI6.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R SCI6 SPIMasterTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* End user code. Do not edit comment generated here */
Now, open the Config_SCI6_user.c file and insert the following code in the user area for global:

/* Start user code for global. Do not edit comment generated here */

/* Flag used locally to detect transmission complete */
static volatile uint8 t s sci6_txdone;

/* End user code. Do not edit comment generated here */

Insert the following code in the transmit end call-back function for SCI6:

static void r Config SCI6_callback transmitend(void)
{
/* Start user code for r Config SCI6_callback transmitend. Do not edit comment generated here */

s_sci6 txdone = TRUE;

/* End user code. Do not edit comment generated here */

}

Now insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

R e

* Function Name: R_SCI6_ SPIMasterTransmit

* Description : This function sends SPI6 data to slave device.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD_OK or MD_ARGERROR

*******************************************************************************/
MD STATUS R _SCI6 SPIMasterTransmit (uint8 t * const tx buf,
const uintl6 t tx num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
S _sci6_txdone = FALSE;

/* Send the data using the API */
status = R Config SCI6 SPI Master Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s sci6_ txdone)
{
/* Wait */
}

return (status);

}

KKK Kk K K K KK K K K K K K K R R R K K R R R K kK R R R K K K R R R kK R R R kK R R R Rk K R kR kK K R R Rk kK

* End of function R SCI6 SPIMasterTransmit
Ak hkkhhkhkhhkhkhkhkhkhhhkhhhkhh bk bk hkhkh bk kb kb hkhkhhkhhkhk bk hkhhkh kb hkhk bk hkhkhkhkhkhkhhkhkhkhkhkhkhkhkrhhkkhkhkhhkrkhdkhkhkxkhx

This function uses the transmit end callback function to perform flow control on the SPI transmission to the
LCD and is used as the main API call in the LCD code module.
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5.2.2 CMT Code

The LCD code needs to insert delays to meet the timing requirements of the display module. This is achieved
using the dedicated timer which was configured using Smart Configurator in §4.5.2. Open the file
‘src\smc_gen\Config_ CMTO0\Config_ CMTO0.h’ and insert the following code in the user area for function at the
end of the file:

/* Start user code for function. Do not edit comment generated here */
void R_CMT MsDelay(const uintl6_t millisec);

/* End user code. Do not edit comment generated here */

Open the file ‘Config_ CMTO_user.c’ and insert the following code in the user area for global at the beginning
of the file:

/* Start user code for global. Do not edit comment generated here */
static volatile uint8 t s one ms delay complete = FALSE;

/* End user code. Do not edit comment generated here */

Scroll down to the r_Config CMTO0_cmiO_interrupt function and insert the following line in the user code area:

static void r Config CMTO cmiO_ interrupt (void)
{
/* Start user code for r Config CMTO cmiO_interrupt. Do not edit comment generated here */

s_one _ms_delay complete = TRUE;

/* End user code. Do not edit comment generated here */

Then insert the following function in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R CMT MsDelay

* Description : Uses CMTO to wait for a specified number of milliseconds

* Arguments : uintl6 t millisecs, number of milliseconds to wait

* Return Value : None
*******************************************************************************/
void R CMT MsDelay (const uintlé t millisec)

{

uintlé_t ms_count = 0;

do
{
R Config CMTO Start();
while (FALSE == s one ms_delay complete)
{
/* Wait */
}
R Config CMTO Stop();
s_one ms_delay complete = FALSE;
ms_count++;
} while (ms_count < millisec);

}

/*******************************************************************************

End of function R CMT MsDelay
~)<~)<~)<******************~)<~)<~)<~)<~)<~)<~)<~)<~)<~)<******************~)<~)<~)<~)<~)<~)<~)<***********************/
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5.3 Additional include paths
Before the project can be built the compiler needs some additional include paths added. Select the
SC_Tutorial project in the Project Explorer pane. Right click in the Project Explorer window and select

'Properties’. Navigate to ‘C/C++ Build -> Settings ->Compiler -> Source and click the £ button as shown in
Figure 5-2.

SC_Tutorial

type filter text Settings - - 8

Resource
-~
Builders
w C/C++ Build Configuration: |HardwareDebug [ Active] ~ | | Manage Configurations...
Build Variables
Environment
Lagging i Tool Settings Toolchain Device # Build Steps Build Artifact Binary Parsers @ Errc 4 | *
Settings
Stack Analysis v & Common Include file directories (-include) [ERERE]
Tool Chain Editor & ceu
C/C++ General @ PIC/PID

"${workspace_loc:/${ProjName}/src}"

v @ Optimization
@ Advanced
@ Output
(% MISRA C Rule Check

workspace_loc/${ProjName}/src/smec_gen/Config_SCle}"
workspace_loc/${ProjName}/src/smec_gen/Config_S12AD0)"
workspace_loc:/${ProjName}/src/smc_gen/general}”

{
i . "&{workspace_loc:/${ProjName}/src/smc_gen/r_bsp}"
Project Natures (&2 Miscellaneous "${workspace_loc:/${ProjName}/src/smc_gen/r_config}”
Project References v i Compiler "${workspace_loc:/${ProjName}/src/smc_gen/Config_CMTO}"
Refactaring History ~ (¥ Source ::&[workspace_\oc:/&[ProJ:Name}Isrc/smc_qen/Conf!g_CMTﬂ::
Renesas QF @ Advanced ${workspace_loc:/${ProjName}/src/smc_gen/Config_CMT2}
. ¥ Object "${workspace_loc:/3{ProjName}/src/smc_gen/Config_ICL}"

Run/Debug Settings % ) "${workspace_loc:/${ProjName}/src/smc_gen/Config_PORT}"
(2 List "${workspace_loc:/${ProjNamel/src/smec_gen/Config_SCI10}"

"3

"8

i

(B Miscellaneous Pre-include files (-preinclude) L2
@ User
~ B3 Assembler v
® Apply and Close Cancel

Figure 5-2 Adding additional search paths

In the ‘Add directory path’ dialog, click the ‘Workspace...’” button and in the ‘Folder selection’ dialog browse to
the ‘SC_Tutorial/src’ folder and click ‘OK’. e? studio formats the path as shown in Figure 5-3 below.

e Add directory path

Directory:

‘ ${workspace_loc:/$(ProjName}/src}

[ Add subdirectories

oK Cancel File system...
Figure 5-3 Adding workspace search path

Close the property by clicking the 'Apply and Close' button shown in Figure 5-2, and when the 'Settings'
dialog shown in Figure 5-4 is appeared, click 'Yes' to finish the setting.

@% Changes made will not be reflected in the index until it is rebuilt. Do you wish to
& rebuild it now?

Yes No

Figure 5-4 Settings dialog

-

Select ‘Build Project’ from the ‘Project’ menu or use the button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in §6. The program will display ‘RSK+RX671
Tutorial Press Any Switch’ on three lines in the LCD display.
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54 Switch Code Integration

API functions for user switch control are provided with the RSK+. Refer to the Tutorial project folder created
according to the Quick Start Guide procedure. Check that the following files are in the src folder:
-rskrx671def.h
-r_rsk_switch.c
-r_rsk_switch.h

Copy these files in to the src folder below the workspace.

The switch code uses interrupt code in the files Config_ICU.h, Config_ICU.c and Config_ICU_user.c and timer
code in the files Config_ CMT1.h, Config_ CMT1.c, Config_ CMT1_user.c, Config_ CMT2.h, Config CMT2.c and
Config_ CMT2_user.c as described in §4.5.2. and §4.5.3 It is necessary to provide additional user code in
these files to implement the switch press/release detection and de-bouncing required by the API functions in
r_rsk_switch.c.

5.4.1 Interrupt Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config_ICU’ folder and open the file ‘Config_ICU.h’ by
double-clicking on it. Insert the following code in the user code area at the end of the file:

/* Start user code for function. Do not edit comment generated here */

/* Function prototypes for detecting and setting the edge trigger of ICU IRQ */

uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no);

void R_ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge);

void R _ICU IRQSetRisingEdge (const uint8 t irqg no, const uint8 t set r edge);

/* End user code. Do not edit comment generated here */
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Now, open the Config_ICU.c file and insert the following code in the user code area at the end of the file:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************

* Function Name: R_ICU IRQIsFallingEdge

Description : This function returns 1 if the specified ICU IRQ is set to
* falling edge triggered, otherwise 0.
* Arguments : uint8 t irqg no

* Return Value : 1 if falling edge triggered, 0 if not

*******************************************************************************/
uint8 t R ICU IRQIsFallingEdge (const uint8 t irqg no)
{ uint8 t falling edge trig = 0x0;

if (ICU.IRQCR[irg no].BYTE & 04 ICU IRQ EDGE_FALLING)

{ falling edge trig = 1;

}

return (falling edge trig);

VARREEEEEE SRR EEE e AR EE Rt EEE Rt EE Rt

* End of function R_ICU IRQIsFallingEdge

*******************************************************************************/

VARREEEEEE S SRR EEE St EEE Rt EEE Rt EE Rt

* Function Name: R ICU IRQSetFallingEdge

* Description : This function sets/clears the falling edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set f edge, 1 if setting falling edge triggered, 0 if

* clearing

* Return Value : None
*******************************************************************************/

void R _ICU IRQSetFallingEdge (const uint8 t irg no, const uint8 t set f edge)
{

if (1 == set_f edge)

{

ICU.IRQCR[irg no].BYTE |= 04 ICU IRQ EDGE FALLING;

}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8_t) ~ 04 ICU IRQ EDGE_FALLING;

/******************************************************************************

* End of function R ICU IRQSetFallingEdge

*******************************************************************************/

VARREEEEEE SRR EEE AR Rt EEEE Rt EE Rt

* Function Name: R_ICU_ IRQSetRisingEdge

* Description : This function sets/clear the rising edge trigger for the

* specified ICU_IRQ.

* Arguments : uint8 t irg no

* uint8 t set r edge, 1 if setting rising edge triggered, 0 if
* clearing

* Return Value : None
*******************************************************************************/

void R_ICU IRQSetRisingEdge (const uint8 t irg no, const uint8 t set r edge)
{
if (1 == set r edge)
{
ICU.IRQCR[irg no] .BYTE |= 08 ICU IRQ EDGE RISING;

}

else

{
ICU.IRQCR[irg no] .BYTE &= (uint8 t) ~ 08 ICU IRQ EDGE RISING;

/******************************************************************************

* End of function R ICU IRQSetRisingEdge

LR EEE RS SRR EE SRR EE AR EEE RSt EEE Rt

/* End user code. Do not edit comment generated here */
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Open the Config_ICU_user.c file and insert the following code in the user code area for include near the top of
the file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irq9_interrupt:

/* Start user code for r Config ICU irqg9 interrupt. Do not edit comment generated here */

/* Switch 1 callback handler */
R_SWITCH IsrCallbackl();

/* End user code. Do not edit comment generated here */

In the same file insert the following code in the user code area inside the function
r_Config_ICU_irg10_interrupt:

/* Start user code for r Config ICU irqglO interrupt. Do not edit comment generated here */

/* Switch 2 callback handler */
R SWITCH IsrCallback2();

/* End user code. Do not edit comment generated here */

5.4.2 De-bounce Timer Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT1 folder and open the
‘Config_ CMT1_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */

In the Config_ CMT1_user.c’ file, insert the following code in the user code area inside the function
r_Config_ CMT1_cmi1_interrupt:

/* Start user code for r Config CMT1 cmil interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT1 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src\smc_gen\Config CMT2' folder and open the file
‘Config_ CMT2_user.c’ file and insert the following code in the user code area for include near the top of the
file:

/* Start user code for include. Do not edit comment generated here */

/* Defines switch callback functions required by interrupt handlers */
#include "r rsk switch.h"

/* End user code. Do not edit comment generated here */
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In the same file insert the following code in the user code area inside the function
r_Config_ CMT2_cmi2_interrupt:

/* Start user code for r Config CMT2 cmi2 interrupt. Do not edit comment generated here */

/* Stop this timer - we start it again in the de-bounce routines */
R Config CMT2 Stop();

/* Call the de-bounce call back routine */
R_SWITCH_DebouncelIsrCallback();

/* End user code. Do not edit comment generated here */

543 Main Switch and ADC Code

In this part of the tutorial we add the code to act on the switch presses to activate A/D conversions and display
the result on the LCD. In §4.5.7 we configured the ADC to be triggered from the ADTRGO# pin, SW3. In this
code, we also perform software triggered A/D conversion from the user switches SW1 and SW2, by
reconfiguring the ADC trigger source on-the-fly once an SW1 or SW2 press is detected.

In the e2 studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’.
Insert the following code the user code area, resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

extern volatile uint8_t g _adc_trigger;

/* End user code. Do not edit comment generated here */

In the e2 studio Project Tree, expand the ‘src’ folder and Open the file ‘SC_Tutorial.c’ and add the highlighted
code, resulting in the code shown below:

#include "r
#include "r
#include "r cg >rdefine.h"
#include "Config S12ADO0.h"
#include "r rsk switch.h"

c _entry.h"
lcd.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb switch press */
static void cb switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6 t adc result);
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Next add the highlighted code below in the main function and the code inside the while loop, resulting in the
code shown below:

void main (void)

{
/* Initialize the switch module */
R_SWITCH Init();

/* Set the call back function when SWl1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb switch press);

/* Initialize the debug LCD */
R LCD Init ();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX671 ");

R _LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0_Start();

while (10U)
{

uintl6é t adc result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g adc_ trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);

/* Reset the flag */
g_adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R_Config S12AD0_Get_ ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Reset the flag */
g_adc_complete = FALSE;
}
else
{
/* do nothing */
}
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Then add the definition for the switch call-back, get adc and lcd_display_adc functions below the main

function, as shown below:

R e

* Function Name : cb switch press

* Description : Switch press callback function. Sets g_adc trigger flag.
* Argument : none
* Return value : none

******************************************************************************/

static void cb_switch press (void)

{
/* Check if switch 1 or 2 was pressed */
if (g switch flag & (SWITCHPRESS 1 | SWITCHPRESS 2))
{

/* set the flag indicating a user requested A/D conversion is required */
g_adc_trigger = TRUE;

/* Clear flag */
g_switch flag = 0x0;
}
}

/******************************************************************************

* End of function cb switch press
******************************************************************************/

/******************************************************************************

* Function Name : get adc

* Description : Reads the ADC result, converts it to a string and displays
* it on the LCD panel.

* Argument : none

* Return value : uintl6 t adc value

******************************************************************************/
static uintl6 t get adc (void)
{

/* A variable to retrieve the adc result */

uintl6é t adc result;

/* Stop the A/D converter being triggered from the pin ADTRGOn */
R Config S12AD0 Stop();

/* Start a conversion */
R S12AD0 SWTriggerStart();

/* Wait for the A/D conversion to complete */
while (FALSE == g adc_complete)
{
/* Wait */
nop () ;
}

/* Stop conversion */
R_S12AD0_SWTriggerStop () ;

/* Clear ADC flag */
g_adc_complete = FALSE;

R _Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Set AD conversion start trigger source back to ADTRGOn pin */
R Config S12AD0 Start();

return (adc_result);

}

R KK KK K K K K K K K K K Kk K R K R K R K R K R ok ok K K R R ok K R ok ok o kK R ok ok kK R ok R kK Rk kR kK

* End of function get adc
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/******************************************************************************

* Function Name : lcd display adc

* Description : Converts adc result to a string and displays
* it on the LCD panel.

* Argument : uintl6_t adc result

* Return value : none

******************************************************************************/

static void lcd display adc (const uintlé_t adc_result)
{

/* Declare a temporary variable */
char t a;

/* Declare temporary character string */
char_t lcd buffer[11] = " ADC: XXXH";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char_t) ((adc_result & 0x0F00) >> 8);

lcd buffer[6] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char t) ((adc_result & 0xO00FO0) >> 4);

lcd buffer[7] = (a < 0xOA) 2 (a + 0x30) : (a + 0x37);
a = (char t) (adc_result & 0x000F);

lcd buffer[8] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);

/* Display the contents of the local string lcd buffer */
R _LCD Display (3, (uint8 t *)lcd buffer);
}

VAR AR EEE RS AR AR R Rt E R R R R R Rt

* End of function lcd display adc
******************************************************************************/

In the e? studio Project Tree, expand the ‘src\smc_gen\general’ folder and open the file ‘r_cg_userdefine.h’ by
double-clicking on it. Insert the following type define in between the user code delimiter comments as shown
below.

/* Start user code for type define. Do not edit comment generated here */

typedef char char t;

/* End user code. Do not edit comment generated here */

In the e? studio Project Tree, expand the ‘src\smc_gen\Config S12ADOQ’ folder and open the file
‘Config_S12ADO0.h’ by double-clicking on it. Insert the following code in the user code area for function,
resulting in the code shown below:

/* Start user code for function. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
extern volatile uint8 t g adc complete;

/* Functions for starting and stopping software triggered A/D conversion */
void R _S12AD0_SWTriggerStart (void);
void R S12AD0 SWTriggerStop (void) ;

/* End user code. Do not edit comment generated here */
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Open the file ‘Config_S12ADO0.c’ by double-clicking on it. Insert the following code in the user code area for
adding at the end of the file, as shown below:

/* Start user code for adding. Do not edit comment generated here */

/*******************************************************************************
* Function Name: R S12AD0 SWTriggerStart

* Description : This function starts the ADO converter.

* Arguments : None

* Return Value : None
*******************************************************************************/

void R _S12AD0_SWTriggerStart (void)
{
IR (PERIB, INTB183) = 0U;
IEN (PERIB, INTB183) = 1U;
S12AD.ADCSR.BIT.ADST = 1U;
}

VAREEEEEEE Rt SRR R EE Rt e R R R EE Rttt EREEE e EEE Rt

End of function R S12AD0_SWTriggerStart

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k**************************/

VAREEEEE Rt SRR AR R EE Rt e e R R EE R Rt EREEE R Rt

* Function Name: R S12AD0 SWTriggerStop
* Description : This function stops the ADO converter.
* Arguments : None

* Return Value : None
*******************************************************************************/

void R S12AD0_SWTriggerStop (void)

{
S12AD.ADCSR.BIT.ADST = 0U;
IEN (PERIB, INTB183) = 0U;
IR(PERIB, INTB183) = 0U;

}

VAREEEEEEE Rt SRR R R EE e R R R EE R Rt EREEE Rttt EEE Rt

End of function R S12AD0 SWTriggerStop

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k**************************/

/* End user code. Do not edit comment generated here */

Open the file Config_S12ADO0_user.c and insert the following code in the user code area for global, resulting in
the code shown below:

/* Start user code for global. Do not edit comment generated here */

/* Flag indicates when A/D conversion is complete */
volatile uint8 t g adc complete;

/* End user code. Do not edit comment generated here */
Insert the following code in the user code area of the r_Config_S12ADO0_interrupt function, resulting in the
code shown below:

static void r Config S12AD0 interrupt (void)
{

/* Start user code for r Config S12AD0 interrupt. Do not edit comment generated here */
g_adc_complete = TRUE;

/* End user code. Do not edit comment generated here */

-

Select ‘Build Project’ from the ‘Project’ menu or use the % button. e? studio will build the project with no
errors.

The project may now be run using the debugger as described in §6. When any switch is pressed, the
program will perform an A/D conversion of the voltage level on the RV1 potentiometer line and display the
result on the LCD panel. Return to this point in the Tutorial to add the UART user code.
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5.5 Debug Code Integration

API functions for trace debugging via the RSK+ serial port are provided with the RSK+. Refer to the Tutorial
project folder created according to the Quick Start Guide procedure. Check that the following files are in the
src folder:

r_rsk_debug.c

r_rsk_debug.h

Copy these files in to the src folder below the workspace.

In the r_rsk_debug.h file, ensure the following macro definition is included:

/* Macro for definition of serial debug transmit function - user edits this */
#define SERIAL_ DEBUG WRITE (R _SCI10 AsyncTransmit)

This macro is referenced in the r_rsk_debug.c file and allows easy re-direction of debug output if a different
debug interface is used.

5.6 UART Code Integration
5.6.1 SCI Code

In the e? studio Project Tree, expand the ‘src\smc_gen\Config SCI10’ folder and open the file
‘Config_SCI10.h’ by double-clicking on it. Insert the following code in the user code area at the end of the file:
/* Start user code for function. Do not edit comment generated here */

/* Exported functions used to transmit a number of bytes and wait for completion */
MD STATUS R _SCI10 AsyncTransmit (uint8 t * const tx buf, const uintl6 t tx num);

/* Character is used to receive key presses from PC terminal */
extern uint8 t g rx char;

/* End user code. Do not edit comment generated here */

Open the file ‘Config_SCI10_user.c’. Insert the following code in the user area for global near the beginning of
the file:

/* Start user code for global. Do not edit comment generated here */

/* Global used to receive a character from the PC terminal */
uint8 t g_rx char;

/* Flag used locally to detect transmission complete */
static volatile uint8 t s scilO_ txdone;

/* End user code. Do not edit comment generated here */

In the same file, insert the following code in the user code area inside the
r_Config_SCI10_callback_transmitend function:
static void r Config SCI10 callback transmitend (void)
{
/* Start user code for r Config SCI10 callback transmitend. Do not edit comment generated here */

s _scil0 txdone = TRUE;

/* End user code. Do not edit comment generated here */
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In the same file, insert the following code in the user code area inside the
r_Config_SCI10_callback_receiveend function:

static void r Config SCI10 callback receiveend(void)

{

/* Start user code for r Config SCI10 callback receiveend. Do not edit comment generated here */

/* Check the contents of g rx char */
if (('c' == g rx char) || ('C' == g rx char))
{
g_adc_trigger = TRUE;
}

/* Set up SCI10 receive buffer and callback function again */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* End user code. Do not edit comment generated here */

At the end of the file, in the user code area for adding, add the following function definition:

/*********************************************‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k************************

* Function Name: R SCI10 AsyncTransmit

* Description : This function sends SCI10 data and waits for the transmit end flag.
* Arguments : tx buf -

* transfer buffer pointer

* tx num -

* buffer size

* Return Value : status -

* MD OK or MD ARGERROR

***********************:********:********‘k*‘k******‘k****************************/
MD_STATUS R_SCI10_AsyncTransmit (uint8 t * const tx_buf, const uintl6_t tx_ num)

{
MD_STATUS status = MD_OK;

/* Clear the flag before initiating a new transmission */
s_scilO_txdone = FALSE;

/* Send the data using the API */
status = R Config SCI10 Serial Send(tx buf, tx num);

/* Wait for the transmit end flag */
while (FALSE == s_scil0O_txdone)
{
/* Wait */
}

return (status);

}

/*******************************************************************************

* End of function R SCI10 AsyncTransmit

KKK K KKK KKK KK KK KKK KK K K R KKK K K R K KRR K K K R R R A K K K R AR A KK KA AR A KKK KKK KKK KA KKK KA XXX KKKk [

5.6.2 Main UART code

Open the file ‘SC_Tutorial.c’. Add the following declaration to near the top of the file:

#include "r smc _entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12AD0.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb_switch press (void);

/* Prototype declaration for get adc */
static uintl6 t get adc(void);
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/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintl6é_t adc_ result);

/* Prototype declaration for uart display adc */

static void uart display adc(const uint8 t adc count, const uintl6é t adc_result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc count = 0;

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1l or SW2 is pressed */
R_SWITCH_SetPressCallback(cb_switch_press);

/* Initialize the debug LCD */
R _LCD Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX671 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R _Config S12AD0_Start();

/* Set up SCI10 receive buffer and callback function */
R Config SCI10 Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R Config SCI10 Start();

while (10)
{

uintlé_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SWl1 or SW2)
if (TRUE == g_adc_trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get_adc();

/* Display the result on the LCD */
lcd display adc(adc_result);

/* Increment the s_adc_count */
if (16 == (++s_adc_count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

/* Reset the flag */
g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R Config S12AD0O_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count */
if (16 == (++s_adc _count))
{

s_adc_count = 0;

}

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);

*/
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/* Reset the flag */
g_adc_complete = FALSE;
}

else

{
/* do nothing */
}

Then, add the following function definition in the end of the file:

VAR AR AR EEEEE RS E R e E R R e

* Function Name : uart display adc

* Description : Converts adc result to a string and sends it to the UART.
* Argument : uint8 t : adc count

* uintlé t: adc result

* Return value : none

‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k***********************/

static void uart display adc (const uint8 t adc_count, const uintlé_t adc_result)

{

/* Declare a temporary variable */
char_t a;

/* Declare temporary character string */
char t uart buffer[] = "ADC xH Value: xxxH\r\n";

/* Convert ADC result into a character string, and store in the local.
Casting to ensure use of correct data type. */

a = (char t) (adc_count & 0x000F);

uart buffer[4] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char_t) ((adc_result & 0x0F00) >> 8);

uart buffer[14] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char t) ((adc_result & 0xO00FO0) >> 4);

uart buffer[15] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);
a = (char_t) (adc_result & 0xO000F);

uart buffer[l6] = (a < 0x0A) ? (a + 0x30) : (a + 0x37);

/* Send the string to the UART */
r debug print (uart buffer);
}

/‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k‘k********************************‘k‘k‘k‘k************************

* End of function uart display adc

LR EEEE RS EEEEEEE R EE R Rt EE R

Select ‘Build Project’ from the ‘Project’ menu. e? studio will build the project with no errors.

The project may now be run using the debugger as described in §6. Connect the RSK+ G1CUSBO port to a
USB port on a PC. If this is the first time the RSK+ has been connected to the PC then a device driver will be
installed automatically. Open Device Manager, the virtual COM port will be appeared under 'Port (COM &

LPT) as 'RSK+ USB Serial Port (COMx)", where x is a number.

Open a terminal program, such as HyperTerminal, on the PC with the same settings as for SCI10 (Baudrate:

19200, Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None).

When any switch is pressed, or when ‘c’ is sent via the COM port, the program will perform an A/D conversion
of the voltage level on the RV1 potentiometer line and display the result on the LCD panel and send the result

to the PC terminal program via the SCI10.
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5.7 LED Code Integration

Open the file ‘SC_Tutorial.c’. Add the following declaration to the near the top of the file:

#include "r smc _entry.h"
#include "r okaya lcd.h"
#include "r cg userdefine.h"
#include "Config S12ADO.h"
#include "r rsk switch.h"
#include "r rsk debug.h"
#include "Config SCI10.h"
#include "rskrx67ldef.h"

/* Variable for flagging user requested ADC conversion */
volatile uint8 t g adc_trigger = FALSE;

/* Prototype declaration for cb_switch press */
static void cb _switch press (void);

/* Prototype declaration for get adc */
static uintl6_t get adc(void);

/* Prototype declaration for lcd display adc */
static void lcd display adc (const uintlé t adc_result);

/* Prototype declaration for uart display adc */
static void uart display adc(const uint8 t adc count, const uintl6 t adc result);

/* Variable to store the A/D conversion count for user display */
static uint8 t s_adc_count = 0;

/* Prototype declaration for led display count */
static void led display count (const uint8 t count);

Add the following highlighted code in the main function:

void main (void)

{
/* Initialize the switch module */
R SWITCH Tnit();

/* Set the call back function when SW1 or SW2 is pressed */
R_SWITCH SetPressCallback(cb_switch press);

/* Initialize the debug LCD */
R _LCD_Init();

/* Displays the application name on the debug LCD */
R _LCD Display (0, (uint8 t *)" RSK+RX671 ");

R_LCD Display(l, (uint8 t *)" Tutorial ");

R_LCD Display(2, (uint8 t *)" Press Any Switch ");

/* Start the A/D converter */
R Config S12AD0O Start();

/* Set up SCI10 receive buffer and callback function */
R _Config SCI10_ Serial Receive((uint8 t *)&g rx char, 1);

/* Enable SCI10 operations */
R _Config SCI10_Start();

while (10)
{
uintl6_t adc_result;

/* Wait for user requested A/D conversion flag to be set (SW1 or SW2) */
if (TRUE == g_adc trigger)
{

/* Call the function to perform an A/D conversion */

adc_result = get adc();

/* Display the result on the LCD */
lcd display adc(adc result);
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/* Increment the s _adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */
uart display adc(s_adc_count, adc result);
/* Reset the flag */
g _adc_trigger = FALSE;
}
/* SW3 is directly wired into the ADTRGOn pin so will
cause the interrupt to fire */
else if (TRUE == g adc complete)
{
/* Get the result of the A/D conversion */
R Config S12AD0_Get ValueResult (ADCHANNELO, &adc_result);

/* Display the result on the LCD */
lcd display_adc(adc_result);

/* Increment the s_adc_count and display using the LEDs */
if (16 == (++s_adc_count))
{
s_adc_count = 0;
}

led display count (s_adc count);

/* Send the result to the UART */
uart display adc(s_adc count, adc result);
/* Reset the flag */
g_adc_complete = FALSE;
}

else

{
/* do nothing */
}

Then, add the following function definition at the end of the file:

[ KKk ok ok ok ok kA A A A KKK Kk k ok ok ok kKA A K KA KKk Kk k ok ok kKA A KKK KKK Kk k ok ok ok kA A KA KK &k ko k ok ok ok ok

* Function Name : led display count

* Description : Converts count to binary and displays on 4 LEDSO0-3
* Argument : uint8 t count

* Return value : none

******************************************************************************/
static void led display count (const uint8 t count)

{

/* Set LEDs according to lower nibble of count parameter */

LEDO = (uint8 t) ((count & 0x01) ? LED ON : LED OFF);
LEDL = (uint8 t) ((count & 0x02) ? LED ON : LED OFF);
LED2 = (uint8_t) ((count & 0x04) ? LED ON : LED OFF);
LED3 = (uint8 t) ((count & 0x08) ? LED ON : LED OFF);

}

/******************************************************************************

* End of function led display count
Kk hkhkhkhkhkhkhkhkhhkhkhkhkhkhkhhk bk h ok bk h bk hhk bk hkhkh ok bk hkhkhhkhkhkhkhhkhkhkhkhhkhkkhhhkhkkhkhhkhkhkhkhkhkhkhkhkhkhkhkhkhkkhkkkkkx

|

Select ‘Build Project’ from the ‘Project’ menu or use the " ® ~ button. e? studio will build the project with no

errors.

The project may now be run using the debugger as described in §6. The code will perform the same but now
the LEDs will display the s_adc_count in binary form.
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6. Debugging the Project

In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To enter the configurations,

click upon the arrow next to the debug button: jl"fls;E and select ‘Debug Configuration’.

e Debug Configurations

Create, ge, and run config . ’**%
R BY- Name: [SC_Tutorial HarchwareDebug |
[type fiter text | 5 Debugger| - Startup| & Source| [ Common

[£] C/C++ Application Eaz

[T] C/C++ Remote Application

5 EASE Script [sC_Tutorial Browse...

[t] GDB Hardware Debugging C/C++ Application:

[ GDB Simulator Debugging (RHES0)
Java Applet

Java Application Variables... Search Project... Browse...
@ Launch Group

[T Remote Java Application

| HardwareDebug/SC_Tutorial.x

Build (if required) before launching

~ [t Renesas GDB Hardware Debugging Build Configuration: | Select Automatically ~
[t SC_Tuterial HardwareDebug . .
£ Renesas Simulator Debugging (RX, RL7E) (O Enable auto build (O Disable auto build
@ Use workspace settings Configure Workspace Settings...
Revert Apply
Filter matched 12 of 14 items — i

Figure 6-1 Debug Configurations

In order to execute the project, it is necessary to change the following settings in ‘Renesas GDB Hardware
Debugging’ -> ‘SC_Tutorial HardwareDebug’ -> ‘Debugger’ -> ‘Connection Settings’.

Set ‘Power Target From The Emulator (MAX 200mA)’ to ‘No’, set ‘Extal Frequency [MHz]' and 'Operating
Frequency [MHz] to the correct frequency. (They should not use the 'Enter' key after typing in values.)

These can be found from the device schematics (in the case of RSK+RX671 set the EXTAL Frequency:
24.0000, Operating Frequency: 120.000).

For more information on powering the RSK+RX671 please refer to the User's Manual.

« Debug Configurations

Create, manage, and run configurations

CEeEXIBY- Marme: [SC_Tutorial HardwareDebug
[type filter text | Main [BEHUNER & Startup| ' - Source| ] Common

[€] C/C++ Application

[E] C/C4+ Remote Application Debug hardware: | E2 Lite (RX) ~| Target Device: | RSFS671E

=/ EASE Script

[£] GDB Hardware Debugging GDB Seﬂmgs Debug Tool Settings

&7 GDB Simulator Debugging (RHE50) « Clock a

Java Applet Main Clock Source EXTAL v

Java Application Extal FrequencylMHz] 52,0000

@ Launch Group Operating Frequency [MHz] 120,000

Bl Remote Java Application Permit Clock Source Change On Writing Internal Flash Memary Yes %2

~ [&7] Renesas GDB Hardware Debugging < Connection with Target Board
[£7] SC_Tutorial HardwareDebug Emulator {Auto)

Renesas Simulator Debugging (RX, RL78) Connection Type ITag v
JTag Clock Frequency[MHz] 6.00 ~
Fine Baud Rate[Mbps] .50
Hot Plug No v

~ Power
Power Target From The Emulator (MAX 200mA) v
33

Supply Voltage (V)
~ CPU Operating Mode
Register Setting Single Chip v

Figure 6-2 Connection Settings

When the setting is complete, press the 'Apply' button followed by the "Close" button to close the debug
configuration window.
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Connect the E2 Lite to the PC and the RSK+ E1/E2 Lite connector. Connect the Pmod LCD to the PMOD1
connector. Connect the center positive +5V PSU to the PWR connector on the RSK+ and apply power.
In the Project Explorer pane, ensure that the ‘SC_Tutorial’ project is selected. To debug the project, click the

button. The dialog shown in Figure 6-3 will be displayed.

e Confirm Perspective Switch

This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for
displaying the debug stack, variables and breakpoints.

Switch to this perspective?

Figure 6-3 Perspective Switch Dialog

Click ‘Remember my decision’ to skip this dialog later. Click ‘Switch’ to confirm that the debug window
perspective will be used. The debugger will start up and the code will stop at the Smart Configurator function
‘PowerOn_Reset PC’ as shown in Figure 6-4.

e Workspace - SC_Tutorial/src/smc_gen/r_bsp/mcu/all/resetprg.c - e studio

File Edit Source Refactor MNavigate Search Project Renesas Views Run  Window Help

I@I - é, - ¥ = - | i 7&@ Debug w | | £ SC_Tutorial HardwareDebug hd
&, ~ 45 vBdiwiE g Q
35 Debug =] |i'=€>|@<9 § = g
w [£7 SC_Tutorial HardwareDebug [Renesas GDB Hardware Debugging]
w ¥ SC_Tutorial.x [1] [cores: 0]
w o Thread #11 (single core) [core: 0] (Suspended: Signal : SIGTRAP:Trace/breakpoint trap)
= PowerON_Reset_PC() at resetprg.c:191 Oxffe026fa
pe| me-elf-gdb -rx-force-isa=v3 -m-force-double-fpu (7.8.2)
s Renesas GDB server (Host)

I8 resetprg.c X = 0
@ * Function name: PowerON_Reset P[] -~
ffep26fa - R_BSP_POR_FUNCTION(R_BSP_STARTUP_FUNCTION)

/* Stack pointers are setup prior to calling this function - see comments above */

= /* You can use auto variables in this function but such variables other than registe
* will be unavailable after you change the stack from the I stack to the U stack (i

[T R TR N

= /* The bss sections have not been cleared and the data sections have not been initia
* and constructors of C++ objects have not been executed until the _INITSCT() is ex
— #if defined(_ GNUC__
= #if BSP_CFG_USER_STACK ENABLE ==
INTERNAL_NOT_USED(ustack_area);
#endif
INTERNAL_NOT_USED(istack_area);
#endif

= #if defined(_ CCR¥_ ) || defined(_ GNUC_ )

[ I Y R S ]

Figure 6-4 Debugger start up screen

For more information on the e? studio debugger refer to the Tutorial manual. To run the code click the L
button. The debugger will stop again at the beginning of the main function. Press U again to run the code.
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7. Additional Information

Technical Support

the help file by opening e? studio, then Window | Help
selecting Help > Help Contents from the T
menu bar. i [q@ Welcome

(7) Help Contents

|- !

4" Search

Show Contextual Help

For information about the RX671 group microcontroller refer to ‘RX671 Group User’s Manual: Hardware’.
For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.
Technical Contact Details

Please refer to the contact details listed in section 8 of the “Quick Start Guide”.

General information on Renesas microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2021 Renesas Electronics Europe GmbH. All rights reserved.
© 2021 Renesas Electronics Corporation. All rights reserved.

R20UT4885EG0100 Rev. 1.00 RENESAS Page 63 of 66
May.10.21



https://www.renesas.com/

REVISION HISTORY

RX671 Group
Renesas Starter Kit+ for RX671
Smart Configurator Tutorial Manual For e? studio

Rev.

Date

Description

Page

Summary

1.00

May.10.21

First Edition issued

C-1




RX671 Group
Renesas Starter Kit+ for RX671
Smart Configurator Tutorial Manual For e? studio

Publication Date: Rev. 1.00 May.10.21

Published by: Renesas Electronics Corporation




RX671 Group

LENESAS

Renesas Electronics Corporation R20UT4885EG0100



	1.    Overview
	1.1 Purpose
	1.2 Features

	2.    Introduction
	3.    Project Creation with e2 studio
	3.1 Introduction
	3.2 Creating the Project

	4.    Smart Configurator Using the e2 studio
	4.1 Introduction
	4.2 Project Configuration using Smart Configurator
	4.3  The ‘Board’ tabbed page
	4.3.1 Board configuration page

	4.4  The ‘Clocks’ tabbed page
	4.4.1 Clocks configuration

	4.5  The ‘System’ tabbed page
	4.5.1 On-chip debug

	4.6 The ‘Components’ tabbed page
	4.6.1 Add a software component into the project
	4.6.2 Compare Match Timer
	4.6.3 Interrupt Controller
	4.6.4 Ports
	4.6.5 SCI/SCIF Asynchronous Mode
	4.6.6 SPI Clock Synchronous Mode
	4.6.7 Single Scan Mode S12AD

	4.7 The ‘Pins’ tabbed page
	4.7.1 Change pin assignment of a software component

	4.8 Building the Project

	5.    User Code Integration
	5.1 Project Settings
	5.2 LCD Code Integration
	5.2.1 SPI Code
	5.2.2 CMT Code

	5.3  Additional include paths
	5.4  Switch Code Integration
	5.4.1 Interrupt Code
	5.4.2 De-bounce Timer Code
	5.4.3 Main Switch and ADC Code

	5.5 Debug Code Integration
	5.6 UART Code Integration
	5.6.1 SCI Code
	5.6.2 Main UART code

	5.7 LED Code Integration

	6.    Debugging the Project
	7.    Additional Information



